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Overview

Would you like to add powerful and easy-to-use Bluetooth Low Energy to your robot, art or other electronics project? Heck yeah! With BLE now
included in modern smart phones and tablets, its fun to add wireless connectivity. So what you really need is the new Adafruit Bluefruit LE Micro -
it's an Atmega32u4 chip (same as used as in the Adafruit Flora (http://adafru.it/dVI) or Arduino Leonardo (http://adafru.it/dy8)) plus our SPI Bluefruit
LE Friend (http://adafru.it/fLp) in one.

Bluetooth Low Energy is the hottest new low-power, 2.4GHz spectrum wireless protocol. It's on all the talk shows, it's featured on the cover of
Vogue, it even has it's very own perfume! OK, maybe that stuff isn't completely true. But it is a very exciting way to have your electronic projects
communicate with a BLE-capable computer, tablet or phone.

In particular, its the only wireless protocol that you can use with iOS without needing special certification and it's supported by all modern smart
phones. This makes it excellent for use in portable projects that will make use of an iOS or Android phone or tablet.

Program over USB with the Arduino IDE

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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https://www.adafruit.com/product/659
https://www.adafruit.com/product/849
https://www.adafruit.com/product/2633

The Bluefruit LE Micro makes this easier than ever, by combining an ATmega32u4 microcontroller and our Bluefruit LE module. You can program
the ATmega32u4 over USB using the built-in USB bootloader, either directly with avrdude or using the Arduino IDE (it's the same as used as in the
Adafruit Flora (http://adafru.it/dVI) or Arduino Leonardo (http://adafru.it/dy8). This microcontroller runs at 8MHz clock speed, and 3.3V logic for
compatibility with the vast majority of sensors available on the market. It has 20+ GPIO pins, including 12C, SPI, a UART, and 6 analog inputs. It
has 28KB of FLASH available for your program, and 2KB of RAM. And, of course, native USB for programming and communication.

You can also add a rechargable Lithium Polymer battery by picking up a LiPoly backpack(http://adafru.it/eOw). Solder it on top of the Bluefruit LE
Micro and it will let you charge the battery over the micro USB connector. When the USB is unplugged, it will run off the battery.

The Power of Bluefruit LE

The Bluefruit LE module is an nRF51822 chipset from Nordic, programmed with multi-function code that can do quite a lot! For most people, they'll
be very happy to use the standard Nordic UART RX/TX connection profile. In this profile, the Bluefruit acts as a data pipe, that can 'transparently’
transmit back and forth from your iOS or Android device. You can use our iOS App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G), or write
your own to communicate with the UART service (http://adafru.it/iCF).

The board is capable of much more than just sending strings over the air! Thanks to an easy to learrAT command set (http://adafru.it/iCG), you
have full control over how the device behaves, including the ability to define and manipulate your own GATT Services and

Characteristics (http://adafru.it/iCH), or change the way that the device advertises itself for other Bluetooth Low Energy devices to see. You can
also use the AT commands to query the die temperature, check the battery voltage, and more, check the connection RSSI or MAC address, and
tons more. Really, way too long to list here!

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect&hl=en
file:///introducing-the-adafruit-bluefruit-le-uart-friend/uart-service
file:///introducing-the-adafruit-bluefruit-le-uart-friend/command-mode-1
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Use the Bluefruit App to get your project started

Using our Bluefruit iOS App (http://adafru.it/iCi) or Android App (http://adafru.it/f4G), you can quickly get your project prototyped by using your iOS
or Android phone/tablet as a controller. We have a color picker (http://adafru.it/iCl), quaternion/accelerometer/gyro/magnetometer or location
(GPS) (http://adafru.it/iCl), and an 8-button control game pad (http://adafru.it/iCl). This data can be read over BLE and piped into the ATmega32u4
chip for processing & control

Once you get the hang of our using the Bluefruit app, you can experiment with making your own custom AppOne option is using Cordova - you
still have to do a little programming but its much easier than doing it from scratch (http://adafru.it/iOf)

You can do a lot more too!

e The Bluefruit can also act like an HID Keyboard (http://adafru.it/iOA), Mouse or Media Controller (for devices that support BLE HID)

e Can become a BLE Heart Rate Monitor (http://adafru.it/iOB) (a standard profile for BLE) - you just need to add the pulse-detection circuitry

e Turn it into a UriBeacon (http://adafru.it/iOC) (now called Eddystone (http://adafru.it/fSA)), the Google standard for Bluetooth LE beacons.
Just power it and the 'Friend will bleep out a URL to any nearby devices with the UriBeacon app installed.

o Built in over-the-air bootloading capability so we can keep you updated with the hottest new firmware(http://adafru.it/iOD). Use any Android
or iOS device to get updates and install them. This will update the native code on the BLE module, to add new wireless capabilities, not
program the ATmega chip.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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file:///bluefruit-le-connect-for-ios/controller#sensors
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file:///bluefruit-le-micro-atmega32u4-microcontroller-usb-bluetooth-le-in-one/downloads
file:///introducing-the-adafruit-bluefruit-spi-breakout/hidkeyboard
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https://github.com/google/eddystone
file:///introducing-the-adafruit-bluefruit-spi-breakout/dfu-updates
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Each order comes with one fully assembled and tested Bluefruit LE Micro board. The ATmega32u4 on board comes with a USB bootloader for
quick programming. The BLE module comes with our latest firmware. We also include some headers which you can solder in to use the module in
a solderless breadboard.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
microcontroller-usb-bluetooth-le-in-one
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Pinouts

There's a lot going on in this board so lets do a high-level overview of major components, then dig into the individual pinouts

Major Parts

There's a few major components you need to know about.

ﬂq ]
000066660606680

Starting from the left, there's the Micro USB connector. This is how you power and program the Bluefruit Micro. If you added on the LiPoly
backpack you can also recharge the battery this way.

R_T,‘L §
000000000606680

To the right is a small tactile switch. This is the reset button for the ATmega32u4. You can use this to reset the microcontroller and/or push it into
bootloader mode if the bootloader gets 'stuck’ during programming

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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This is the main microcontroller, an ATmega32u4 chip. This chip has 32KB of flash (4KB taken by bootloader, 28K available for user code), 2.5KB
of RAM, and lots of GPIO. It runs at 8MHz and 3.3V logic. It is the same chip used as in the Adafruit Flora (http://adafru.it/dVI) or Arduino

Leonardo (http://adafru.it/dy8) so if you have used those, then this chip will be very familiar. You can use the Arduino IDE to program this chip once
you add the board with the Board Manager and many (although not 100%) of Arduino libraries will work out-of-the-box.

Finally there's the BLE module. This is the radio-handling part. It is an FCC/CE-certified emittermodule with a ceramic antenna. The ATmega32u4
talks to this module over SPI using our Arduino library to transmit and receive data. It is based on the nRF51822 chipset from Nordic
Semiconductor.

Power Pins

These are the pins you'll be connecting to for power input and output.
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e BAT is a battery input port. If you are using the LiPoly backpack, this connects to the lithium ion/polymer batter. You can also inject any other
kind of battery in here, from 3-16VDC. It has a Schottkey diode for polarity protection

o G & GND - There are 3 ground pins available

e USB is the 'raw' 5V power from the USB port when power is coming in via USB. You can use this if you need up to 500mA current @ 5V but
its only live when USB is connected

e 3V This is the output from the onboard regulator, 3.3V output at 150mA

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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LEDs

There are four indicators for telling you what is up with your Bluefruit Micro

The two LEDs on the left next to the MicroUSB jack are

o Red #13 LED which is connected to digital #13 / PC7 of the ATmega32u4. You can use it to signal or blink. It will also 'pulse’ on and off when
the bootloader is active
e Green ON LED this LED is always on when the board is powered.

The two LEDs on the right next to the BLE module are

o Red BLE status LED This LED will blink 3 times every few seconds to let you know that the BLE module is alive and running/waiting for
connection. It's also used when doing a DFU update on the module.
* Blue BLE connection LED lights up when a device is connected via BLE.

BLE Use Pins

These pins are used to talk to the module. You can use the MOSI/MISO/SCK pins for other SPI devices (we use SPI transactions to avoid data
collisions) but keep the 3 other pins unused for anything else.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

P 15 of 11
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« Digital 4 - connected to the Bluefruit Reset pin, resets the BLE module when set to low.

o Digital 7 - the IRQ from the Bluefruit to the microcontroller. Used for the Bluefruit to tell the microcontroller when new data arrived/is ready to
read

« Digital 8 - the Bluefruit CS pin, used to select the module for data transfer.

e MOSI/MISO/SCK - SPI pins used to send/receive data and commands between the microcontroller and BLE

Available GPIO

There's a ton of pins available!

All of these pins are digital input/output pins, with 3.3V logic.Some have extra capabilities

#0 - Hardware UART RX pin

#1 - Hardware UART TX pin

#2 - 12C SDA (data) pin

#3 - 12C SCL (clock) pin

#5 - PWM (analogWrite) output
#9 - PWM (analogWrite) output
#10 - PWM (analogWrite) output
#11 - PWM (analogWrite) output
#12 - GPIO

#13 - Connected to a red LED next to the micro USB jack
AO thru A5 - Analog inputs.

You can also use the SCK/MOSI/MISO pins with an SPI device as long as it is on a Chip Select line and you disable it when you talk to the BLE
module.

Other Pins

e ARef - This is the analog reference input for the ATmega32u4, you can use this to change the analog reference fomnalogRead() however
do not set higher than 3.3V (which is the default, also)

e DFU - This is used when updating the firmware on the BLE module itself. Don't use unless you need/want to update the BLE device runcode.
It will not reprogram the ATmega32u4

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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Using with Arduino IDE

Install Drivers (Windows Only)

Start out by installing the serial/CDC drivers for the Bluefruit LE Micro. We'll be using PJRC's awesome generic CDC drivers, works with all
Windows and all CDC devices. (Thanks Paul!) (http:/adafru.it/fLA)

Mac/Linux does not need a driver, continue as is!

Install Bluefruit Micro board support

Chances are you want to jump right in and start programming the Bluefruit Micro! The fastest/easiest way to do that is to use the Arduino IDE.
You'll need v1.6.4 or greater, which has a Board Manager support.

Check out that guide first, to add Adafruit Boards support!(http://adafru.it/f7X)

OK now that you are back, launch the IDE and select Bluefruit Micro from theBoards menu

" . e ATQUIND KODOT MOTOT B
22 atcommand | Arduine 1.6.4 o R mrin Carmenn ]
File Edit Sketch [Tools| Help Arduinc ARM (32-bits] Boards
Auto Format CrleT Arduino Due (Programming Port)
— Archive Sketch Arduino Due (Native USB Port)
SlEommane Fix Encoding & Reload ESPR Modules
Serial Monitor Ctrl+Shift« M Generic ESP8266 Module
Board: "Adafruit Bluefru..." ' Adafruit HUZZAH ESPB266
== \  NodeMCU 09 (ESP-12 Module)
NodeMCU 1.0 (ESP-12E Module)
e .. '
A S Olimex MOD-WIFI-ESP8266(-DEV)

e SparkFun ESP8266 Thing

SweetPea ESP-210

Adafruit Boards
Adafruit Flora
@ Adafruit Bluefruit Micro

| L5 #inelude <Arduine.h> Adafruit Gemma 8MHz

finclude <SPI.h> Adafruit Trinket 8MHz
#if not defined (_VARIANT_ARDUINO_DUE_X_ ) && m Adafruit Trinket 16MHz

Ubuntu & Linux Issue Fix

Note if you're using Ubuntu 15.04 (or perhaps other more recent Linux distributions) there is an issue with the modem manager service which
causes the Bluefruit LE micro to be difficult to program. If you run into errors like "device or resource busy", "bad file descriptor", or "port is busy"
when attempting to program then you are hitting this issue. (http://adafru.it/fP6)

The fix for this issue is to make sure Adafruit's custom udev rules are applied to your system. One of these rules is made to configure modem
manager not to touch the Bluefruit Micro board and will fix the programming difficulty issue. Follow the steps for installing Adafruit's udev rules on
this page. (http://adafru.it/iOE)

Install the Adafruit nRF51 BLE Library

In order to try out our demos, you'll need to download the Adafruit BLE library for the nRF51 based modules such as this one (a.k.a.
Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, (http://adafru.it/f4V) but its likely easier to just download by clicking:

Download the Adafruit nRF51 Bluetooth Library
http://adafru.it/f4W

Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the Adafruit_BluefruitLE_nRF51 folder contains
Adafruit_BLE.cpp and Adafruit_BLE.h (as well as a bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolder/libraries/ folder.
You may need to create thelibraries subfolder if its your first library. Restart the IDE.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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http://www.adafruit.com/datasheets/PJRC CDC serial_install.zip
file:///add-boards-arduino-v164
https://bugs.launchpad.net/ubuntu/+source/modemmanager/+bug/1473246
file:///adafruit-arduino-ide-setup/linux-setup#udev-rules
https://github.com/adafruit/Adafruit_BluefruitLE_nRF51
https://github.com/adafruit/Adafruit_BluefruitLE_nRF51/archive/master.zip

We also have a great tutorial on Arduino library installation at:
http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use (http://adafru.it/a¥YM)

After restarting, check that you see the library folder with examples:

(22l sketch_may01la | Arduing |
Edit Sketch Tools Help

New
Open...
Sketchbook
Examples
Close

Save

Save As...
Upload

Upload Using Programmer

Page Setup
Print

Preferences

Ctrl+N
Ctrl+O

Ctrl+W
Ctrl+5
Ctrl+Shift+5
Ctrl+U
Ctrl+Shift+U

Ctrl+Shift+P
Ctrl+P

Ctrl+Comma

Adafruit 9DOF
Adafruit_ADS1015
Adafruit_ADXL345_U
Adafruit_AHRS
Adafruit_AM2315
Adafruit_AS53935
Adafruit_BLEFirmata

Adafruit_BLEModule_SPISlave

Adafruit_BluefruitLE_nRF51
Adafruit_BMPO85
Adafruit_BMP085_Unified
Adafruit_BMP183
Adafruit_BMP183_Unified
Adafruit_BNO055
Adafruit_CAP1188

Run first example

atcommand

beacon

bleuart
factoryreset
heartrateronitor
hidkeyboard

uribeacon

Lets begin with the beginner project, which we can use to do basic tests. To open the ATCommand sketch, click on théile > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selectatcommand:

Adafruit_AHRS
Adafruit_BluefruitLE_nRF51
Adafruit_BMP085_Unified
Adafruit_BMP183_Unified_Library
Adafruit_BNO055
Adafruit_CC3100
Adafruit_DHT_Unified
Adafruit_DotStar
Adafruit_FONA_Library

YVVYVYVYVYYVYYRAAY

atcommand
beacon

bleuart
factoryreset
heartratemonitor
hidkeyboard
uribeacon

This will open up a new instance of the example in the IDE, as shown below:

© Adafruit Industries
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-
@ atcommand | Arduine 1.6.4 R ==

File Edit Sketch Tools Help

atcommand

LAl
(Bfile atcommand. ino
Bauthor  hathach

m

This example shows how to comnect to your Adafruit Bluefruit LE (nrf51822) and do
gome basic AT commands to check comnectivity, print out the version strings and let
you send your own AT commands'

*/

#include <string.hs

#include <Arduine.h>

#include <SPI.h>

#if not defined (_VARTANT_ARDUINO_DUE_X_)
finclude <SoftwareSerial.h>

dendif

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE_UART.h"

/¢4 If you are using Software Serial....
J/ The following macros declare the pins used for 5V serial, you should
// use these pins if you are connecting the UART Friend te an UND

#define BLUEFRUIT SWUART REXD_PIN g /f Required for software serial!
|| 24 8ime Brememrrr cwmranT Ten nrw 1 24 Poomadpsd Soy poSeszows sowdadl M |
4 i *

ne on COMZ54

Don't upload the sketch yet! You will have to begin by changing the configuration.
Go to the second tab labeled BluefruitConfig.h and find these lines

// SHARED SPI SETTINGS
I
/I The following macros declare the pins to use for HW and SW SPI communication.
/I SCK, MISO and MOSI should be connected to the HW SPI pins on the Uno when
// using HW SPI. This should be used with nRF51822 based Bluefruit LE modules
// that use SPI (Bluefruit LE SPI Friend).

/I

#define BLUEFRUIT_SPI_CS 8

#define BLUEFRUIT_SPI_IRQ 7

#define BLUEFRUIT_SPI_RST 6 // Optional but recommended, set to -1 if unused

And change the last line to:

#define BLUEFRUIT_SPI_RST 4 // Optional but recommended, set to -1 if unused
(The Bluefruit Micro has the reset on digital #4 not #6)

Now go back to the main tabatcommand and look for this line of code

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

Make sure that the second line is uncommented (it should be)

OK now you can upload to the Bluefruit Micro!
If you're using Ubuntu 15.04 or other Linux distributions and run into errors attempting to upload a program to the board, scroll up to the Ubuntu
and Linux issue fix section above.

Uploading to the Bluefruit Micro

It's pretty easy to upload, first up make sure you haveBluefruit Micro selected on the boards dropdown as above. Also, in thePorts menu, look
for the port labeled as such:

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industries ) .
microcontroller-usb-bluetooth-le-in-one

Page 19 of 113



File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch
ateommand Fix Encoding & Reload
. Serial Monitor Ctrl+Shift+ M
3 Board: "Adafruit Bluefru..." L4
4
5 Port } Serial ports
€ . Ccom1
N Programmer: "USBtinyISP" }
7 comi2
a Burn Bootloader
: COMBS [Adafruit Bluefruit Micro)
10
I 11
| 1z

Now click the upload button on the Arduino IDE (orFile Menu -> Upload)

If all is good you will see Done Uploading in the status bar

F e T e E
atcommand | Arduinc 1.6.4 EI_M

File Edit Sketch Tools Help

atcommand

ra
]

16 #imelnds shedbnine ke

4 | i | r

Adafruit Bluefruit

Uploading to a brand new board/Upload failures

If you are uploading for the first time to a new board, or if upload fails, pres theRESET mini button on the Bluefruit Micro when you see the Yellow
Arrow lit and the Uploading... text in the status bar. When you see the red LED pulsing on and off, you know the bootloader is running.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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atcommand | Arduinc 1.6.4 E@ﬂ

AR , i
File Edit Sketch Tools Help

atcommand

Adafruit Bluefruit
=

Don't click the reset button before uploading, unlike other bootloaders you want this one to run at the time Arduino is trying to upload

Run the sketch

OK check again that the correct port is selected

| (25! atcommand | Arduing 1.

File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch
ateommand Fix Encoding & Reload
. Serial Monitor Ctrl+Shift+ M
3 Board: "Adafruit Bluefru..." L4
4
5 Port } Serial ports
€ . Ccom1
N Programmer: "USBtinyISP" }
7 comi2
a Burn Bootloader
: COMBS [Adafruit Bluefruit Micro)
10
11
I 1z

Then open up the Serial console. You will see the following:

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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COMBS (Adafruit Bluefruit Micro)

mﬁlg

RAdafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: OK!
Performing a factory reset:
AT+FACTORYRESET

<- OK
LTE=0

<- OK

Requesting Bluefruit info:
BLESFIFRIEND

nRF51822 QFACRIO0
6992R79TD32E2839

0.6.5

0.6.5

Jul 1 2015

5110 &.0.0, 0.2

Autoscroll BothNL&CR v | 115200 baud

h

This sketch starts by doing a factory reset, then querying the BLE radio for details. These details will be useful if you are debugging the radio. If

you see the information as above, you're working! (Note that the dates and version numbers may vary)

AT command testing

Now you can try out some AT commands - check the rest of the learn guide for a full list. We'll just start withAT+HWGETDIETEMP which will
return the approximate ambient temperature of the BLE chipset

COMS (Adafruit Bluefruit Micro] - h@l@lﬂ

Performing a factory reset:
AT+FACTORYRESET

<- OK
LTE=0

<- OK

Requesting Bluefruit info:
BLESFIFRIEND

nRF51822 QFACRIO0
6992R79T7D32E2839

m

Autoscroll BothNL&CR

115200 baud

© Adafruit Industries
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COMGS (Adafruit Blusfruit Micro) [E=EEEE
AT+HWGETDIETEMP

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: COK!
Performing a factory reset:
AT+FACTORYRESET

<- 0K
ATE=0

<- OK

Requesting Bluefruit info:
BLESFIFRIEND

nRF51822 QFACRIO0
6992R79T7D32E2839

0.6.5

0.6.5

Jul 1 2015

5110 &.0.0, 0.2

Autoscroll BothNL&CR v | 115200 baud

OK now you know how to upload/test/‘communicate with your Bluefruit Micro. Next up we have a bunch of tutorials who can follow for checking out
the bluetooth le radio and apps.

For all the following examples, we share the same code between various modules sodon't forget to make sure you have the RESET pin set to
4 in BluefruitConfig.h for each sketch before uploading, and that Hardware SPI mode is selected by checking that

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

Is uncommented

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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Configuration!

Before you start uploading any of the example sketches, you'll need to CONFIGURE the Bluefruit interface - there's a lot of options so pay close
attention!

Which board do you have?

There's a few products under the Bluefruit name:

If you are using the Bluefruit LE Shield then you have anSPI-connected NRF51822
module. You can use this with Atmega328 (Arduino UNO or compatible), ATmega32u4
(Arduino Leonardo, compatible) or ATSAMD21 (Arduino Zero, compatible) and possibly
others.

Your pinouts are Hardware SPI, CS =8, IRQ =7, RST =4

Bluefruit Micro or Feather 32u4 Bluefruit

If you have a Bluefruit Micro or Feather 32u4 Bluefruit LE then you have an
ATmega32u4 chip with Hardware SPI, CS =8, IRQ =7, RST =4

Feather MO Bluefruit LE

If you have a Feather MO Bluefruit LE then you have anATSAMD21 chip with Hardware
SPI, CS =8, IRQ =7, RST =4

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4- Page 24 of 113
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Configure the Pins Used

Bluefruit LE SPI Friend

If you have a stand-alone module, you have a bit of flexibility with wiring however we
strongly recommend Hardware SPI, CS =8, IRQ =7, RST =4

You can use this with just about any microcontroller with 5 or 6 pins

Bluefruit LE UART Friend or Flora BLE

If you have a stand-alone UART module you have some flexibility with wiring. However
we suggest hardware UART if possible. You will likely need to use the flow controlCTS
pin if you are not using hardware UART. There's also a MODE pin

You can use this with just about any microcontroller with at least 3 pins, but best used
with a Hardware Serial/lUART capable chip!

You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or SPI

Each example sketch has a secondary tab with configuration details. You'll want to edit and save the sketch to your own documents folder once

set up.

atcommand | A

[File Edit Sketch Tools Help

i BluefruitConfig.h
// COMMON SETTINGS
ryy

;

#define BUFSIZE
#define VERBOSE_MODE

// SOFTWARE UART SETTINGS

7

// These settings are used in both 5W UART, HVW UART and SPI mode

// Size of the read buffer for incoming data
‘true' enables debug output

J = e e e

// The following macros declare the pins that will be used for 'SW' serial.
// You should use this option if you are connecting the UART Friend to an UNO

© Adafruit Industries

#define BLUEFRUIT SWUART FXD_FIN

/F Bequired for software serial!
EAnfime DUNETRIITT CIMTANT TRT RTH '

JEY PEE S S 1
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Common settings:

You can set up how much RAM to set aside for a communication buffer and whether you want to have full debug output. Debug output is 'noisy' on
the serial console but is handy since you can see all communication between the micro and the BLE

I
// These settings are used in both SW UART, HW UART and SP| mode
Vi
#define BUFSIZE 128 // Size of the read buffer for incoming data
#define VERBOSE_MODE true // If set to 'true’ enables debug output

Software UART

If you are using Software UART, you can set up which pins are going to be used for RX, TX, and CTS flow control. Some microcontrollers are
limited on which pins can be used! Check the SoftwareSerial library documentation for more details

// SOFTWARE UART SETTINGS

#define BLUEFRUIT_SWUART_RXD_PIN 9 // Required for software serial!

#define BLUEFRUIT_SWUART_TXD_PIN 10 // Required for software serial!

#define BLUEFRUIT_UART_CTS_PIN 11 // Required for software serial!
#define BLUEFRUIT_UART_RTS_PIN -1 // Optional, set to -1 if unused

Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Serial1 - you can set that up here:
// HARDWARE UART SETTINGS
#ifdef Serial1  // this makes it not complain on compilation if there's no Serialt

#define BLUEFRUIT_HWSERIAL_NAME  Serial1
#endif

Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin. There's a few sketches that dont use it, instead depending on
commands to set/unset the mode. Its best to use the MODE pin if you have a GPIO to spare!

#define BLUEFRUIT_UART_MODE_PIN 12 // Setto -1 if unused

SPI Pins

For both Hardware and Software SPI, you'll want to set theCS (chip select) line, IRQ (interrupt request) line and if you have a pin to spare,RST
(Reset)

/I SHARED SPI SETTINGS

#define BLUEFRUIT_SPI_CS 8
#define BLUEFRUIT_SPI_IRQ 7
#define BLUEFRUIT_SPI_RST 4 // Optional but recommended, set to -1 if unused

Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad slower but very flexible

/| SOFTWARE SPI SETTINGS

#define BLUEFRUIT_SPI_SCK 13
#define BLUEFRUIT_SPI_MISO 12
#define BLUEFRUIT_SPI_MOSI 11

Refer to the table above to determine whether you have SPI or UART controlled Bluefruits!

Select the Serial Bus

Once you've configured your pin setup in the BluefruitConfig.h file, you can now check and adapt the example sketch.

The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options, depending on the HW you are using:SPI both hardware and
software type, and UART both hardware and software type.

UART Based Boards (Bluefruit LE UART Friend & Flora BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can useeither software serial or hardware serial. Hardware serial is higher quality,
and less risky with respect to losing data. However, you may not have hardware serial available! Software serial does work just fine with flow-

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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control and we do have that available at the cost of a single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software serial contructor below, and make sure the other three
options (hardware serial & SPI) are commented out.

// Create the bluefruit object, either software serial...uncomment these lines
SoftwareSerial bluefruitSS = SoftwareSerial(BLUEFRUIT_SWUART_TXD_PIN, BLUEFRUIT_SWUART_RXD_PIN);

Adafruit_BluefruitLE_UART ble(bluefruitSS, BLUEFRUIT_UART_MODE_PIN,
BLUEFRUIT_UART_CTS_PIN, BLUEFRUIT_UART_RTS_PIN);

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the hardware serial constructor, and make sure the other three options
are commented out

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line */
Adafruit_BluefruitLE_UART ble(BLUEFRUIT_HWSERIAL_NAME, BLUEFRUIT_UART_MODE_PIN);

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below, making sure the other constructors are commented out:

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_CS, BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

If for some reason you can't use HW SPI, you can switch to software mode to bit-bang the SPI transfers via the following constructor:

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user selected CS/IRQ/RST */
Adafruit_BluefruitLE_SPI ble(BLUEFRUIT_SPI_SCK, BLUEFRUIT_SPI_MISO,
BLUEFRUIT_SPI_MOSI, BLUEFRUIT_SPI_CS,
BLUEFRUIT_SPI_IRQ, BLUEFRUIT_SPI_RST);

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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BLEUart

The BLEUart example sketch allows you to send and receive text data between the Arduino and a connected Bluetooth Low Energy Central
device on the other end (such as you mobile phone using the Adafruit Bluefruit LE Connect application for Android (http://adafru.it/f4G) or
iOS (http://adafru.it/f4H) in UART mode).

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select
bleuart_cmdmode:

Adafruit_AHRS [ 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

bleuart_cmdmede | Arduino 1.6.4 - - -‘@M

File Edit Sketch Tools Help

bleuart_cmdmode §

rEa! -
Gfile bleuart_cmdwode. ino
[fauthor hathach, ktown (Adafruit Industries)

This demo will show you how to send and receive data in COMMAND mode | &
(without needing to put the module into DATA mode or using the MODE pin)

*/

#include <string.hs

#include <Arduino.h>

#include <SPI.h>

#include <SoftwareSerial.h>

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE_UART.h"

// If you are using Software Serial....
// The following macros declare the pins used for 5W serial, you should
// use these pins if you are connecting the TUART Friend to |an Qo]

#define ELUEFRUIT_SWUART FXD_FPIN 9 /4 Bequired for software serial!l
#define BLUEFRUIT_SWUART TXD_FPIN 10 // Bequired for software serial!
#define BLUEFRUIT_UART_CTS_PIN 11 // Bequired for software serial!
#define ELUEFRUIT_UART_RTS_PIN -1 /4 Optional, set to -1 if unused

// If you are using Hardware Serial
// The following macros declare the Serial port you are using. Uncomment this

P8 Vdamm §E smmna mmen damcr #lac DIT 4m Tomcmmcaede /W& cee ca T1oaeo

4 [ | +

Adafruit Flora on

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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If using software or hardware Serial UART:
e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a

MODE pin
e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COM250 (Adafruit Flora) =NACN X
RAdafruit Bluefruit Command Mode Example -

Initialising the Bluefruit LE module: ATZ

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0
0K
Requesting Bluefruit info:

m

BLEFRIEND32
nRF51822 QFACRLO0
D5321FT75475B19EE
0.8.2

0.8.2

Zpr 30 2015

5110 &.0.0, 0.2
[v):4

Please use Adafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

Autoscroll :No line ending :9600 baud -

Once you see the request, use the App to connect to the Bluefruit LE module ilJART mode so you get the text box on your phone

Any text that you type in the box at the top of the Serial Monitor will be sent to the connected phone, and any data sent from the phone will be
displayed in the serial monitor:

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
microcontroller-usb-bluetooth-le-in-one
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COM250 (Adafruit Flora_- [E=SREERr

[ [(send ]

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
|ATE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B19EE
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

Please use Adafruit Bluefruit LE app to connect in UART mode
Then Enter characters to send to Bluefruit

ko kkk

[Send] Hello, Adafruit!

-

m

x|

[¥] Autoscrol [Noline ending | 9600 baud

You can see the incoming string here in the Adafruit Bluefruit LE Connect app below (iOS in this case):

© Adafruit Industries
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Hello, Adafruit!

Why hello, Arduino! Send

space

The response text ('Why hello, Arduino!’) can be seen below:

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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COM250 (Adafruit Flo_ [E=SREERr

| [(send ]

-

<- OK
OK!
Performing a factory reset: AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
| |IBELEFRIEND32
nRF51822 QFACRIO0
D5321F75475B19EE
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

m

||Flease use Adafruit Bluefruit LE app to connect in URRT mode
Then Enter characters to send to Bluefruit

ko kkk

[Send] Hello, Adafruit!
[Recwv] Why helleo, Arduinc!

[¥] Autoscrol [Noline ending v | [9600baud

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

Adafruit In ri
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ATCommand

The ATCommand example allows you to execute AT commands from your sketch, and see the results in the Serial Monitor. This can be useful
for debugging, or just testing different commands out to see how they work in the real world. It's a good one to start with!

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selectatcommand:

Adafruit_ AHRS >

Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon

v

Adafruit_FONA_Library

This will open up a new instance of the example in the IDE, as shown below:

B atcommand | Arduino 1.64 R S ——— =Bl
File Edit Sketch Tools Help

atcommand

LAl
Bfile atcommand. ino
Bauthor  hathach

m

This example shows how to comnect to your Adafruit Bluefruit LE (nrf51822) and do
some basic AT commands to check connectivity, print out the wversion strings and let
you send your own AT commands'

*/

#include <string.hs

#include <Arduine.h>

#include <SPI.h>

#if not defined (_VARTANT_ARDUINO_DUE_X_)
finclude <SoftwareSerial.h>

dendif

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE_UART.h"

/¢4 If you are using Software Serial....

J/ The following macros declare the pins used for 5V serial, you should

// use these pins if you are connecting the UART Friend te an UND

#define BLUEFRUIT SWUART FXD_PIN ) /f Required for software serial!

M samaine mrimemsrre comane ma new B i Reilead Hai sedeiies siuiasi |
4 i m 13

Arduine Uno on COM259

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI
If using software or hardware Serial UART:

e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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MODE pin

e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor

via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

[ (g2 COM250 (Adafruit Flora) ! )

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module:
ATZ

<- OK

OK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B19EE
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

Autoscroll

:Nohneenmng v: :9600baud

To send an AT command to the Bluefruit LE module, enter the command in the textbox at the top of the Serial Monitor and click th&end button:

ATI

Send

The response to the AT command will be displayed in the main part of the Serial Monitor. The response fromATI' is shown below:

© Adafruit Industries
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[ NN ] /dev/cu.usbmodem1411131

Send

BLE AT COMMAND EXAMPLE
Initialising the Bluefruit LE module: OK!
Performing a factory reset: OK!
BLEFRIEND32
nRFS1822 QFACAL
DEB72(43325A1718
@.6.5
@.6.5
Apr 3@ 2015
5110 8.8.9, 0.2
AT > ATI
BLEFRIEND32
nRF51822 QFACALR
DEB72(43325A1718
@.6.5
@.6.5
Apr 30 2015
511e 8.8.0, 0.2
0K
AT >

™ Autoscroll You've pressed Send b... No line ending 3 115200 baud 3

You can do pretty much anything at this prompt, with the AT command set. TnAT+HELP to get a list of all commands, and try out ones like
AT+HWGETDIETEMP (get temperature at the nRF51822 die) and AT+HWRANDOM (generate a random number)

- —
COM250 (Adafruit Flora) =] 0

[ =N
[OK -
Requesting Bluefruit info:

BLEFRIEND32
nRF51822 QFACRLO0
D5321F75475B19EE

A
r BR
r W
by LA
o =1
:
H
=]
&
g
A m
=

[¥] Autoscrol [Noline ending | 9600 baud

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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HIDKeyboard

The HIDKeyboard example shows you how you can use the built-in HID keyboard AT commands to send keyboard data to any BLE-enabled
Android or iOS phone, or other device that supports BLE HID peripherals.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select
hidkeyboard:

Adafruit_AHRS [ 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library »> bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

hidkeyboard

vold setup(void) <

Serial.begin{l15200);
Serial.y In(F("BLE HID FEYBOAFD EXAMPLE")):
Serial.println(F("------—---—mmmmm oo "1

/* Inictialise the module */
Serial.print(F{"Initialising the Bluefruit LE module: "});

if { !ble.begin() )

{

(1 Serial.printin( F("FAILED! (Check your wiring?)"™) ):
while(l) ()}

¥

Serial.printin{ F{"0K!"}) };

f* Perform a factory reset to make sure everything is in a known state %/
Serial.print(F{"Pecforming a factory reset: ")):
EXECUTE( ble.factoryReset() ):

(| /* Disable command echo from Bluefruit */
ble.echo(falze);

/* Set ble command verbose */

A* Print Bluefruit information */
ble.info():

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:
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e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD mode!
e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COM250 (Adafruit Flora) [E=SREER
|

RAdafruit Bluefruit HID Keyboard Example - i

Initialising the Bluefruit LE module: I
ATZ

<- OK

OK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B198E
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

m

Setting device name to "Bluefruit EKeyboard':
AT+GAPDEVNAME=Blusefruit Keyboard

<- OK
Enable Keyboard Service:
AT+BleKeyboardEn=0n

<- OK
Performing & SW reset (service changes reguire a reset):
ATZ

<- 0K

Go to your phone's Bluetocoth settings to pair your device
then open an application that accepts keyboard input

Enter the character(s) to send:
- \r for Enter

- \n for newline

- \t for tab

- \b for backspace

keyboard > -

:No line ending v: :115200 baud v:

Autoscroll

To send keyboard data, type anything into the textbox at the top of the Serial Monitor and click theSend button.

Bonding the HID Keyboard

Before you can use the HID keyboard, you will need to 'bond' it to your phone or PC. The bonding process establishes a permanent connection
between the two devices, meaning that as soon as your phone or PC sees the Bluefruit LE module again it will automatically connect.

The exact procedures for bonding the keyboard will varying from one platform to another.

When you no longer need a bond, or wish to bond the Bluefruit LE module to another device, be sure to delete the bonding information on the
phone or PC, otherwise you may not be able to connect on a new device!

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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Android

To bond the keyboard on a Bluetooth Low Energy enabled Android device, go to theSettings application and click the Bluetooth icon.

These screenshots are based on Android 5.0 running on a Nexus 7 2013. The exact appearance may vary depending on your device and OS
version.

Wireless & networks

¥ WiFi 3 Bluetooth

(Q Datausage e« More

Inside the Bluetooth setting panel you should see the Bluefruit LE module advertising itself asBluefruit Keyboard under the 'Available devices'
list:

< Bluetooth

On

Available devices G

3 69:0C:12:C6:2A:75
EE  Bluefruit Keyboard
% 14:99:E2:05:29:CF

Nexus 7 is visible to nearby devices while Bluetooth Settings is open.

Tapping the device will start the bonding process, which should end with the Bluefruit Keyboard device being moved to a new 'Paired devices' list
with 'Connected' written underneath the device name:

Paired devices

Bluefruit Keyboard Q

Connected

To delete the bonding information, click the gear icon to the right of the device name and the click thé&Forget button:
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Paired devices
Name

Bluefruit Keyboard

Use for

Input device

FORGET oK

To bond the keyboard on an iOS device, go to the Settings application on your phone, and click the Bluetooth menu item.

The keyboard should appear under the OTHER DEVICES list:
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®0e00 Free & 15:27 70} mm

< Settings Bluetooth

Bluetooth

Now discoverable as “iPhone de Kevin”.

MY DEVICES

SONY:CMT-X5CD Not Connected (i)

OTHER DEVICES -,
Adafruit Bluefruit LE

To pair an Apple Watch with your iPhone, go to the Apple
Watch app.

Once the bonding process is complete the device will be moved to theMY DEVICES category, and you can start to use the Bluefruit LE module as
a keyboard:

MY DEVICES
Bluefruit Keyboard Connected @
SONY:CMT-X5CD Not Connected @

To unbond the device, click the 'info' icon and then select theForget this Device option in the menu:

< Bluetooth Bluefruit Keyboard

Forget This Device

OS X

To bond the keyboard on an OS X device, go to the Bluetooth Preferences window and click the Pair button beside the Bluefruit Keyboard
device generated by this example sketch:
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sen = —

Devices Ead
e Bluefruit Keyboard Pair
Bluetooth: On
Turn Bluetooth Off
Now discoverable as
“Kevin's MacBook Pro”
¥ Show Bluetooth in menu bar Advanced... ?

To unbond the device once it has been paired, click the small 'x' icon besideBluefruit Keyboard:

een | Bletoot

Devices i.-‘

Bluefruit Keyboard o)

Connected

Bluetooth: On
Turn Bluetooth Off
Now discoverable as
“Kevin's MacBook Pro”
¥ Show Bluetooth in menu bar Advanced... ?

... and then click the Remove button when the confirmation dialogue box pops up:

Are you sure you want to remove “Bluefruit Keyboard”?
You have to pair this device a.gain if you want to use it later.

Cancel Remove
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Controller

The Controller sketch allows you to turn your BLE-enabled iOS or Android device in a hand-held controller or an external data source, taking
advantage of the wealth of sensors on your phone or tablet.

You can take accelerometer or quaternion data from your phone, and push it out to your Arduino via BLE, or get the latest GPS co-ordinates for
your device without having to purchase (or power!) any external HW.

Opening the Sketch

To open the Controller sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selectcontroller:

Adafruit AHRS

Adafruit_BluefruitLE_nRF51 atcommand
Adafruit_ BMP085_Unified beacon
Adafruit_ BMP183_Unified_Library bleuart_cmdmode

Adafruit CC3100
Adafruit_DHT_Unified
Adafruit_DotStar

Adafruit. FONA_Library
Adafruit_HMC5883_Unified
Adafruit_L3GD20_U
Adafruit_LSM303DLHC

bleuart_datamode
controller
factoryreset
heartratemonitor
hidkeyboard
uribeacon

VVYVYVYYVYVYY VYAl

This will open up a new instance of the example in the IDE, as shown below:

controller | Arduino 1.6.4

winclude <string.h=
#include <Arduino. b
#include <5P1.h>

8 #include <Sof

#include ”
#include "A
+ #include

clare the pins used fo
nY if i Q connecting the L

#define BLUEFRULT_SWUART_RXD_PIN

@ #define BLUEFRUIT_SWUART_TXD_PIN
#define BLUEFRUTT_UART_CTS_PIN
#define BLUEFRUIT_UART_RTS_PIN

#define BLUEFRUTT _HWSERTAL MAME

Other recommended pins!

2 #define BLUEFRUIT_UMRT_MOOE_PIM 12 Optional but recommended, set to -1 if wused

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI
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If using software or hardware Serial UART:

e This tutorial will also be easier to use if you wire up the MODE pin, you can use any pin but our tutorial has pin 12 by default. You can change

this to any pin. If you do not set the MODE pin then make sure you have the mode switch in CMDmode

e If you are using a Flora or otherwise don't want to wire up the Mode pin, set the BLUEFRUIT_UART_MODE_PIN to -1 in the configuration
tab so that the sketch will use the +++ method to switch between Command and Data mode!
e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

13

0K !

/devicu.usbmodem1411131

Send

Performing o foctory reset: AT+FACTORYRESET

<~ AT+FACTORYRESET
0K
ATE=8

<- ATE=B

0K

Requesting Bluefruit info:
BLEFRIEND3Z
nRF51822 QFACAL®
B789692ZAERBCI491
0.6.2

0.6.2

Apr 38 2015
5110 8.8.9, 0.2
0K

Please use Adafruit Bluefruit LE app to connect in Controller mode
Then activate/use the sensors, color picker, game controller, etc!

Ig Autoscroll

No line ending 115200 baud =

Using Bluefruit LE Connect in Controller Mode

Once the sketch is running you can open Adafruit's Bluefruit LE Connect application (available forAndroid (http://adafru.it/f4G) or
iOS (http://adafru.it/f4H)) and use the Controller application to interact with the sketch. (If you're new to Bluefruit LE Connect, have a look at our
dedicated Bluefruit LE Connect learning guide (http://adafru.it/iCm).)

On the welcome screen, select the Adafruit Bluefruit LE device from the list of BLE devices in range:

all Adafruit Bluefruit LE

-43

UART capable

Connect

Then from the activity list select Controller:

© Adafruit Industries
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https://itunes.apple.com/app/adafruit-bluefruit-le-connect/id830125974?mt=8
file:///bluefruit-le-connect-for-ios/settings

Connect to Adafruit Bluefruit LE
Choose mode:

Info

UART

Pin I/O

Controller

Cancel

This will bring up a list of data points you can send from your phone or tablet to your Bluefruit LE module, by enabling or disabling the appropriate
sSensor(s).

Streaming Sensor Data

You can take Quaternion (absolute orientation), Accelerometer, Gyroscope, Magnetometer or GPS Location data from your phone and send it
directly to your Arduino from the Controller activity.

By enabling the Accelerometer field, for example, you should see accelerometer data update in the app:

Quaternion OFF
Accelerometer
x: 0.15683
y: -0.580338
z: -0.794373
Gyro OFF
Magnetometer OFF
Location

The data is parsed in the example sketch and output to the Serial Monitor as follows:

Accel 0.20 -0.51 -0.76
Accel 0.22 -0.50 -0.83
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Accel 0.25 -0.51 -0.83
Accel 0.21 -0.47 -0.76
Accel 0.27 -0.48 -0.82

[ [ /devicu.usbmodem1411131
| Send
Accel @.16 @8.55 -@.82
Accel @.14 8.53 -8.81
Accel @.17 .52 -0.83
Accel 9.14 0.52 -8.83
Accel @.18 @8.55 -0.78
Accel @.18 @.38 -0.98
Accel @.13 8.37 -1.8
Accel @.16 8.37 -8.92
Accel @.24 .43 9.83
Accel @.20 -8.33 -1.83
Accel @.20 -0.41 -0.93
Accel @.17 8.44 -0.79
Accel @.23 8.51 -@.84
Accel @.20 .48 -8.86
Accel 8.21 0.48 -8.82
Accel @.20 8.50 -@.81
Accel @.21 @8.51 -0.87
Accel @.22 8.43 -0.84
Accel @.20 8.51 -8.76
Accel @.22 .50 9.83
Accel @.25 -8.51 -8.83
Accel @.21 -0.47 -0.76
Accel @.27 9.43 -0.82
™ Autoscroll No line ending  + 115200 baud +

Note that even though we only print 2 decimal points, the values are received from the App as a full 4-byte floating point.

Control Pad Module

You can also use the Control Pad Module to capture button presses and releases by selecting the appropriate menu item:

Control Pad

This will bring up the Control Pad panel, shown below:

Button presses and releases will all be logged to the Serial Monitor with the ID of the button used:

Button 8 pressed
Button 8 released
Button 3 pressed
Button 3 released
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Color Picker Module

You can also send RGB color data via the Color Picker module, which presents the following color selection dialogue:

22:38

Color Picker

R:164 G:47 B:255

This will give you Hexadecimal color data in the following format:
RGB #A42FFF

You can combine the color picker and controller sample sketches to make color-configurable animations triggered by buttons in the mobile app--
very handy for wearables! Download this combined sample code (configured for Feather but easy to adapt to FLORA, BLE Micro, etc.) to get
started:
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feather_bluefruit_neopixel_animation_controller.zip
http://adafru.it/kzF
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HeartRateMonitor

The HeartRateMonitor example allows you to define a new GATT Service and associated GATT Characteristics, and update the characteristic
values using standard AT commands.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select
heartratemonitor:

Adafruit_AHRS [ 2
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library »> bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:

(22l heartratemonitor | Ard

File Edit Sketch Tools Help

hearraternonitar

* -

vold setup (void)

{
Serial.begin(115200) ;
Serial.println(F({"ELE HEART FATE MONITOFR. (HEM) EXAMPLE")):
Serial.println(F(" "

randomSeedinicros());

/* Initialise the module */
Serial.print(F{"Initializsing the Blusfruit LE module: "));

if { 'ble.begin() )

{
Serial.println( F{"FAILED! (Check your wiring?)") ):
whilei{l){}

}

Serial.printlng F("0E!"™) }:

/* Perform a factory reset to make sure everything is in a known state */
Serial.print(F("Performning a factory reset: "));
EXECUTE( ble.factoryReset() ):

/* Disable command echo from Bluefruit */
ble.echo(false);

/* Set ble command verbose */
ble.verbose (VEREOSE_MODE) ; -

4 | i b

Configuration

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industries ) .
microcontroller-usb-bluetooth-le-in-one

Page 48 of 113



Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If Using Hardware or Software UART

This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a
MODE pin

This demo uses some long data transfer strings, so we recommend defining and connecting both CTS and RTS to pins, even if you are using
hardware serial.

If you are using a Flora or just dont want to connect CTS or RTS, set the pin #define's to -1 an®on't forget to also connect the CTS pin on the
Bluefruit to ground! (The Flora has this already done)

If you are using RTS and CTS, you can remove this line below, which will slow down the data transmission
// this line is particularly required for Flora, but is a good idea

/I anyways for the super long lines ahead!
ble.setinterCharWriteDelay(5); // 5 ms

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor
via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COM250 (Adafruit Flora) [ESRIERX

(Rdafruit Bluefruit Heart Rate Monitor (HEM) Example -

Initialising the Bluefruit LE module:
ATZ

m

- OK

jOK !

Performing a factory reset:

AT+FACTORYRESET [ 4

- OK
LTE=0

- RTE=0
[OK
Requesting Bluefruit info:

[[ELEFRIEND32

NRF51822 QFACRLO0

D5321F75475B198E

0.6.2

0.6.2

Apr 30 2015

W|s110 &.0.0, 0.2

[OK

Setting device name to "Bluefruit HEM':
IAT+GAFDEVNAME=Bluefruit HEM

4 | i b

=

:No line ending v: :9600 baud v:
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(& comzso (adaruit Flora) - e R - e e

Setting device name to 'Bluefruit HRM':
AT+GAPDEVNAME=Bluefruit HRM

<- OK

Adding the Heart Rate Service definiction (UUID = 0x180D):
AT+GATTADDSERVICE=UUID=0x180D

<= 1

<- OK

2Adding the Heart Rate Measurement characteristic (UUID = 0x2A37):
AT+GATTADDCHAR=UUID=0x2A37, PROPERTIES=0x10, MIN_LEN=2, MAX LEN=3, VALUE=00-40
<= 1

<= OK

Bdding the Body Sensor Location characteristic (UUID = Ox2RA38):
AT+GATTADDCHAR=UUID=0x2R38, PROFERTIES=0x02, MIN_LEN=1, VALUE=3

<= 2

<= OH
Il' hdding Heart Rate Service TUID to the adwvertising payload: AT+GAPSETADVDATA=0Z-01=-06-05-02=-0d-18-0a=-18

<= O
Performing a 5W reset (service changes require a reset): ATZ

<= QK

Updating HEM value to 82 BEM
AT+GATTCHAR=1,00-52

<= OH
[|Updating HEM value to &1 BEM
AT+GATICHAR=1,00-3D

1

| DRisesa ke sy =, [0

sl |

If you open up an application on your mobile device or laptop that support the standardHeart Rate Monitor Service (http://adafru.it/f4l), you should

be able to see the heart rate being updated in sync with the changes seen in the Serial Monitor:

nRF Toolbox HRM Example

The image below is a screenshot from the free nRE Toolbox (http://adafru.it/e9M) application from Nordic on Android (also available on

iOS (http://adafru.it/f4J)), showing the incoming Heart Rate Monitor data:
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3} .4 = 0312

Jel' BLUEFRUIT HRM

Finger 55

sensor position bpm

80

| /\\ \\
AV

L

BPM
(=]

2 4 6 8 10
Time (seconds)

—=— Heart Rate

DISCONNECT

Wireless by Nordic

CoreBluetooth HRM Example

The image below is from a freely available CoreBluetooth sample application (http://adafru.it/f4K) from Apple showing how to work with Bluetooth
Low Energy services and characteristics:
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@ L Heart Rate Monitor

Connected
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UriBeacon

The UriBeacon example shows you how to use the built-in UriBeacon AT commands to configure the Bluefruit LE module as a UriBeacon
advertiser, following Google's Physical Web UriBeacon (http:/adafru.it/edk) specification.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and selecturibeacon:

Adafruit_ AHRS >

Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNOO055 > factoryreset
Adafruit_CC3100 2 heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon

Adafruit_FONA_Library

v

This will open up a new instance of the example in the IDE, as shown below. You can edit the URL that the beacon will point to, from the default
http://www.adafruit.com or just upload as is to test

@ uribeacon | Arduinc 16.4 [ -]
File Edit Sketch Tools Help
00 BEHR

uribeacon

#define BLUEFRUIT_UART_TXD_PIN i)
#define BLUEFRUIT UART_CTS_PIN (10
#define ELUEFRUIT UART RTS_PIN {11)

//hdafruit_BLE_HVWSPI ble(BLUEFRUIT_SPI_C5_PIN, BLUEFRUIT_SPI_IRQ_PIN /*, BLUEFRUIT_SPI_RST PIN *,
Adafruit_BLE_SWUART ble(BLUEFRUIT_UART RXD_PIN, BLUEFRUIT UART TXD_PIN,
BLUEFRUIT_UART CTS_PIN, ELUEFRUIT UART RTS_PIN, BLUEFRUIT_UART_MODE_PIN);

£
/ ==== ====

#define BUFSIZE 128

// URL that is advertised, it must not longer than 17 (omitted http:// and wv.)
#define URL “htop: //www. adafruit. con”

m

Jnt
Bbrief Helper MACROS to check command execution. Print 'FAILED!' or "OK'',
loop forewver if failed
*

#define EXECUTE (command)
do{ I
if ( '(command) ) { Serial.println( F{"FAILED!™) };: while(l){} }\

Serial.println( F("0E!'™) ):
Jwhile(0) H

Arduine Uno on ©

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:
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e This tutorial does not need to use the MODE pin,make sure you have the mode switch in CMD modeif you do not configure & connect a

MODE pin

e Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not using it{(The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and the upload process has finished, open up the Serial Monitor

via Tools > Serial Monitor, and make sure that the baud rate in the lower right-hand corner is set to115200:

COMZ50 (Adafruit Florz

|

Adafruit Bluefruit UriBeacon Example

Initialising the Bluefruit LE module:
ATZ

<- OK

OK!

Performing a factory reset:
AT+FACTORYRESET

<- 0K
LTE=0

<- RTE=0

0K

Requesting Bluefruit info:
BLEFRIEND32
nRF51822 QFACRIO0
D5321F75475B198E
0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2
0K

Setting uri beacon to Adafruit website: AT+BLEURIBEACON=http://www.adafruit.com

<- 0K

Please use Google Physical Web application to test

Autoscroll :No line ending v: :115200 baud v:

e

At this point you can open the Physical Web Application for Android (http://adafru.it/edi) or for iOS (http://adafru.it/edj), and you should see a link

advertising Adafruit's website:

% o H 16140

Nearby Beacons

Adafruit Industries, Unique & fun DIY electronics and kits
http://www.adafruit.com

Adafruit Industries, Unique & fun DIY electronics and kits : - Tools Gift Certificates Arduino

Cables Sensors LEDs Books Power EL Wire/Tape/Panel Components & Parts LCDs &...
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HALP!

When using the Bluefruit Micro or a Bluefruit LE with Flora/Due/Leonardo/Micro the examples dont run?

We add a special line to setup() to make it so the Arduino will halt until it sees you've connected over the Serial console. This makes debugging
great but makes it so you cannot run the program disconnected from a computer.

Solution? Once you are done debugging, remove these two lines from setup()

while (ISerial);
delay(500);

| can't seem to "Find" the Bluefruit LE!

Getting something like this?

COMZ50 (Adafruit Flora)

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module:
ATZ

<- RATZ

<- RATZ

<- RATZ

<- RATZ

<— Couldn't find Bluefruit, make sure it's in CoMmanD mode & check wiring?

Autoscroll

For UART/Serial Bluefruits:
L]
L]
L]
L]
L]
L]

If using SPI Bluefruit:

:No line ending v: :9600 baud v:

Check you have the MODE switch in CMD and the MODE pin not wired to anything if it isnt used!

If you are trying to control the MODE from your micro, make sure you set the MODE pin in the sketch
Make sure you have RXI and TXO wired right! They are often swapped by accident
Make sure CTS is tied to GND if you are using hardware serial and not using CTS
Check the MODE red LED, is it blinking? If its blinking continuously, you might be in DFU mode, power cycle the module!
If you are using Hardware Serial/Software Serial make sure you know which one and have that set up

e Make sure you have all 5 (or 6) wires connected properly.
e If using hardware SPI, you need to make sure you're connected to the hardware SPI port, which differs depending on the main chipset.

If using Bluefruit Micro:

e Make sure you change the RESET pin to #4 in any Config file. Also be sure you are using hardware SPI to connect!

© Adafruit Industries
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AT Commands

The Bluefruit LE modules use a Hayes AT-style command set (http://adafru.it/ebd)to configure the device.

The advantage of an AT style command set is that it's easy to use in machine to machine communication, while still being somewhat user friendly
for humans.

Test Command Mode '=?'

"Test' mode is used to check whether or not the specified command exists on the system or not.

Certain firmware versions or configurations may or may not include a specific command, and you can determine if the command is present by
taking the command name and appending '=?" to it, as shown below

AT+BLESTARTADV=?

If the command is present, the device will reply with'OK'. If the command is not present, the device will reply with' ERROR'.
AT+BLESTARTADV=?

OK\r\n

AT+MISSINGCMD="?
ERROR\r\n

Write Command Mode '=xxx'

'Write' mode is used to assign specific value(s) to the command, such as changing the radio's transmit power level using the command we used
above.

To write a value to the command, simple append an'=" sign to the command followed by any paramater(s) you wish to write (other than a lone'?"
character which will be interpretted as tet mode):

AT+BLEPOWERLEVEL=-8
If the write was successful, you will generally get an'OK' response on a new line, as shown below:

AT+BLEPOWERLEVEL=-8
OK\r\n

If there was a problem with the command (such as an invalid parameter) you will get aHERROR' response on a new line, as shown below:

AT+BLEPOWERLEVEL=3
ERROR\r\n

Note: This particular error was generated because '3' is not a valid value for the AT+BLEPOWERLEVEL command. Entering -4', '0" or '4vould
succeed since these are all valid values for this command.

Execute Mode

'Execute’ mode will cause the specific command to 'run’, if possible, and will be used when the command name is entered with no additional
parameters.

AT+FACTORYRESET
You might use execute mode to perform a factory reset, for example, by executing the AT+FACTORYRESET command as follows:

AT+FACTORYRESET
OK\r\n

NOTE: Many commands that are means to be read will perform the same action whether they are sent to the command parser in 'execute' or
'read' mode. For example, the following commands will produce identical results:

AT+BLEGETPOWERLEVEL
-4\r\n

OK\r\n
AT+BLEGETPOWERLEVEL?
-4\r\n

OK\r\n

If the command doesn't support execute mode, the response will normally b ERROR' on a new line.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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Read Command Mode '?’

'Read' mode is used to read the current value of a command.

Not every command supports read mode, but you generally use this to retrieve information like the current transmit power level for the radio by
appending a '?' to the command, as shown below:

AT+BLEPOWERLEVEL?
If the command doesn't support read mode or if there was a problem with the request, you will normally get alERROR' response.

If the command read was successful, you will normally get the read results followed byOK' on a new line, as shown below:

AT+BLEPOWERLEVEL?
-4\r\n
OK\r\n

Note: For simple commands, 'Read' mode and 'Execute’ mode behave identically.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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Standard AT

The following standard Hayes/AT commands are available on Bluefruit LE modules:

AT

Acts as a ping to check if we are in command mode. If we are in command mode, we should receive the 'OK' response.

Codebase Revision: 0.3.0
Parameters: None

Output: None

AT
OK

ATI

Displays basic information about the Bluefruit module.
Codebase Revision: 0.3.0

Parameters: None

Output: Displays the following values:

e Board Name

e Microcontroller/Radio SoC Name

e Unique Serial Number

e Core Bluefruit Codebase Revision

e Project Firmware Revision

e Firmware Build Date

o Softdevice, Softdevice Version, Bootloader Version (0.5.0+)

ATI

BLEFRIEND
nRF51822 QFAAG00
FB462DF92A2C8656
0.5.0

0.5.0

Feb 24 2015
$1107.1.0, 0.0

OK

Updates:

o Version 0.4.7+ of the firmware adds the chip revision after the chip name if it can be detected (ex. 'nRF51822 QFAAGO00').
o Version 0.5.0+ of the firmware adds a new 7th record containing the softdevice, softdevice version and bootloader version (ex. 'S110 7.1.0,

0.0).

ATZ

Performs a system reset.
Codebase Revision: 0.3.0
Parameters: None

Output: None

ATZ
OK

ATE
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Enables or disables echo of input characters with the AT parser
Codebase Revision: 0.3.0
Parameters: '1' = enable echo, '0' = disable echo

Output: None

# Disable echo support
ATE=0

OK

#Enable echo support
ATE=1

OK

+++

Dynamically switches between DATA and COMMAND mode without changing the physical CMD/UART select switch.

When you are in COMMAND mode, entering '+++\n' or "+++\r\n' will cause the module to switch to DATA mode, and anything typed into the
console will go direct to the BLUE UART service.

To switch from DATA mode back to COMMAND mode, simply enter '+++\n' or '+++\r\n' again (be sure to include the new line character!), and a
new 'OK' response will be displayed letting you know that you are back in COMMAND mode (see the two 'OK' entries in the sample code below).

Codebase Revision: 0.4.7
Parameters: None
Output: None

Note that +++ can also be used on the mobile device to send and receive AT command on iOS or Android, though this should always be used with
care.

ATI

BLEFRIEND
nRF51822 QFAAG00
B122AAC33F3D2296
0.4.6

0.4.6

Dec 22 2014

OK

+++

OK

OK

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industries . .
microcontroller-usb-bluetooth-le-in-one

Page 59 of 113



General Purpose

The following general purpose commands are available on all Bluefruit LE modules:

AT+FACTORYRESET

Clears any user config data from non-volatile memory and performs a factory reset before resetting the Bluefruit module.
Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+FACTORYRESET
OK

As of version 0.5.0+ of the firmware, you can perform a factory reset by holding the DFU button down for 10s until the blue CONNECTED LED
lights up, and then releasing the button.

AT+DFU

Forces the module into DFU mode, allowing over the air firmware updates using a dedicated DFU app on iOS or Android.
Codebase Revision: 0.3.0

Parameters: None

Output: None

The AT parser will no longer responsd after the AT+DFU command is entered, since normal program execution effectively halts and a full system
reset is performed to start the bootloader code

AT+DFU
OK

AT+HELP

Displays a comma-separated list of all AT parser commands available on the system.
Codebase Version: 0.3.0

Parameters: None

Output: A comma-separated list of all AT parser commands available on the system.

The sample code below may not match future firmware releases and is provided for illustration purposes only

AT+HELP
AT+FACTORYRESET,AT+DFU,ATZ ATI,ATE, AT+DBGMEMRD,AT+DBGNVMRD,AT+HWLEDPOLARITY, AT+HWLED,AT+HWGETDIETEMP ,AT+HWMODEPINPOLARITY AT +HV
OK

AT+NVMWRITE

Writes data to the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0
Parameters:

« offset: The numeric offset for the first byte from the starting position in the user NVM
o datatype: Which can be one of STRING (1), BYTEARRAY (2) or INTEGER (3)
o data: The data to write to NVM memory (the exact payload format will change based on the specified datatype).

Output: Nothing

# Write 32768 as an integer starting at byte 16 in user NVM

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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AT+NVMWRITE=16,INTEGER,32768
OK

AT+NVMREAD

Reads data from the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0
Parameters:

« offset: The numeric offset for the first byte from the starting position in the user NVM

e size: The number of bytes to read

o datatype: The type used for the data being read, which is required to properly parse the data and display it as a response. The value can be
one of STRING (1), BYTEARRAY (2) or INTEGER (3)

Output: The data read back, formatted based on the datatype argument.

# Read an integer back from position 16 in user NVM
AT+NVMREAD=16, 4, INTEGER

32768

OK

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-
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Hardware

The following commands allow you to interact with the low level HW on the Bluefruit LE module, such as reading or toggling the GPIO pins,
performing an ADC conversion ,etc.:

AT+BAUDRATE

Changes the baud rate used by the HW UART peripheral on the nRF51822.
Codebase Revision: 0.7.0
Parameters: Baud rate, which must be one of the following values:

1200
2400
4800
9600
14400
19200
28800
38400
57600
76800
115200
230400
250000
460800
921600
1000000

e O o o o o o o o o o o o o o o

Output: The current baud rate
# Set the baud rate to 115200
AT+BAUDRATE=115200

OK

# Check the current baud rate
AT+BAUDRATE

115200
OK

AT+HWADC

Performs an ADC conversion on the specified ADC pin
Codebase Revision: 0.3.0
Parameters: The ADC channel (0..7)

Output: The results of the ADC conversion
AT+HWADC=0

178
OK

AT+HWGETDIETEMP

Gets the temperature in degree celcius of the BLE module's die. This can be used for debug purposes (higher die temperature generally means
higher current consumption), but does not corresponds to ambient temperature and can nto be used as a replacement for a normal temperature
sensor.

Codebase Revision: 0.3.0
Parameters: None

Output: The die temperature in degrees celcius

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industries . .
microcontroller-usb-bluetooth-le-in-one

Page 62 of 113



AT+HWGETDIETEMP
32.25
OK

AT+HWGPIO

Gets or sets the value of the specified GPIO pin (depending on the pin's mode).

Codebase Revision: 0.3.0

Parameters: The parameters for this command change depending on the pin mode.

OUTPUT MODE: The following comma-separated parameters can be used when updating a pin that is set as an output:

e Pin numbers

e Pin state, where:
o 0 = clear the pin (logic low/GND)
o 1 = set the pin (logic high/VCC)

INPUT MODE: To read the current state of an input pin or a pin that has been configured as an output, enter the pin number as a single
parameter.

Output: The pin state if you are reading an input or checking the state of an input pin (meaning only 1 parameter is supplied, the pin number),
where:

e 0 means the pin is logic low/GND
e 1 means the pin is logic high/VCC

Trying to set the value of a pin that has not been configured as an output will produce an 'ERROR' response.
Some pins are reserved for specific functions on Bluefruit modules and can not be used as GPIO. If you try to make use of a reserved pin number
an 'ERROR' response will be generated.

# Set pin 14 HIGH
AT+HWGPIO=14,1
OK

# Set pin 14 LOW
AT+HWGPIO=14,0
OK

# Read the current state of pin 14
AT+HWGPIO=14

0

OK

# Try to update a pin that is not set as an output
AT+HWGPIOMODE=14,0

OK

AT+HWGPIO=14,1

ERROR

AT+HWGPIOMODE

This will set the mode for the specified GPIO pin (input, output, etc.).
Codebase Revision: 0.3.0
Parameters: This command one or two values (comma-separated in the case of two parameters being used):

e The pin number
e The new GPIO mode, where:
o 0= Input
o 1 = Output
o 2 = Input with pullup enabled
o 3 = Input with pulldown enabled

Output: If a single parameters is passed (the GPIO pin number) the current pin mode will be returned.
Some pins are reserved for specific functions on Bluefruit modules and can not be used as GPIO. If you try to make use of a reserved pin number
an 'ERROR' response will be generated.

# Configure pin 14 as an output
AT+HWGPIOMODE=14,0
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OK

# Get the current mode for pin 14
AT+HWPGIOMODE=14

0

OK

AT+HWI2CSCAN

Scans the 12C bus to try to detect any connected 12C devices, and returns the address of devices that were found during the scan process.

Codebase Revision: 0.3.0

Parameters: None

Output: A comma-separated list of any 12C address that were found while scanning the valid address range on the 12C bus, or nothing is no

devices were found.

# 12C scan with two devices detected
AT+HWI2CSCAN

0x23,0x35

OK

# 12C scan with no devices detected

AT+HWI2CSCAN
OK

AT+HWVBAT

Returns the main power supply voltage level in millivolts
Codebase Revision: 0.3.0

Parameters: None

Output: The VBAT level in millivolts

AT+HWVBAT
3248
OK

AT+HWRANDOM

Generates a random 32-bit number using the HW random number generator on the nRF51822 (based on white noise).

Codebase Revision: 0.4.7

Parameters: None

Output: A random 32-bit hexadecimal value (ex. '0x12345678')

AT+HWRANDOM
0x769ED823
OK

AT+HWMODELED

Allows you to override the default behaviour of the MODE led (which indicates the operating mode by default).

Codebase Revision: 0.6.6

Parameters: LED operating mode, which can be one of the following values:

e o o o o o

or toggle.

© Adafruit Industries

disable or DISABLE or 0 - Disable the MODE LED entirely to save power

mode or MODE or 1 - Default behaviour, indicates the current operating mode

hwuart or HWUART or 2 - Toggles the LED on any activity on the HW UART bus (TX or RX)

bleuart or BLEUART or 3 - Toggles the LED on any activity on the BLE UART Service (TX or RX characteristic)

spi or SPI or 4 - Toggles the LED on any SPI activity

manual or MANUAL or 5 - Manually sets the state of the MODE LED via a second comma-separated parameter, which can beon, off,
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Output: If run with no parameters, returns an upper-case string representing the current MODE LED operating mode from the fields above

# Get the curent MODE LED setting
AT+HWMODELED

MODE

OK

# Change the MODE LED to indicate BLE UART activity
AT+HWMODELED=BLEUART
OK

# Manually toggle the MODE LED
AT+HWMODELED=MANUAL,TOGGLE
OK

AT+UARTFLOW

Enables or disable hardware flow control (CTS + RTS) on the UART peripheral block of the nRF51822.
Codebase Revision: 0.7.0
Parameters: HW flow control state, which can be one of:

e 0N
o Off
e 0
o 1

Output: If run with no parameters, returns a number representing whether flow control is enabled (1) or disabled (0).

# Check the current flow control state
AT+UARTFLOW

1

OK

# Disable HW flow control
AT+UARTFLOW=off
OK
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Beacon

Adafruit's Bluefruit LE modules currently support the following 'Beacon' technologies:

e Beacon (Apple) via AT+BLEBEACON
e UriBeacon (Google) via AT+BLEURIBEACON (deprecated)
o Eddystone (Google) via AT+EDDYSTONE*

Modules can be configured to act as 'Beacons' using the following commands:

AT+BLEBEACON

Codebase Revision: 0.3.0

Parameters: The following comma-separated parameters are required to enable beacon mode:

e Bluetooth Manufacturer ID (uint16_t)
e 128-bit UUID

e Major Value (uint16_t)

e Minor Value (uint16_t)

e RSSI@ 1m (int8_t)

Output: None

# Enable Apple iBeacon emulation

# Manufacturer ID = 0x004C
AT+BLEBEACON=0x004C,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000,-59
OK

# Reset to change the advertising data

ATZ

OK

# Enable Nordic Beacon emulation

# Manufacturer ID = 0x0059
AT+BLEBEACON=0x0059,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-F0,0x0000,0x0000,-59
OK

# Reset to change the advertising data

ATZ

OK

AT+BLEBEACON will cause the beacon data to be stored in non-volatile config memory on the Bluefruit LE module, and these values will be
persisted across system resets and power cycles. To remove or clear the beacon data you need to enter the 'AT+FACTORYRESET' command in

command mode.

Entering Nordic Beacon emulation using the sample code above, you can see the simulated beacon in Nordic's 'Beacon Config' tool below:

© Adafruit Industries
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Moo 2 |l d @ 01:29

(IS Beacon config

nRF Beacon
IDENTITY
UuID 01122334-4556-6778-899a-abbccddeeffo
MAJOR (0)
MINOR 0
NOTIFY
EVENT Near [J-
ACTION Show Mona Lisa [l

ENABLED - oul |

Wireless by Nordic

AT+BLEURIBEACON

Converts the specified URI into a UriBeacon (http://adafru.it/edk) advertising packet, and configures the module to advertise as a UriBeacon (part

of Google's Physical Web (http://adafru.it/ehZ) project).
To view the UriBeacon URIs you can use one of the following mobile applications:

e Android 4.3+: Physical Web (http://adafru.it/edi) on the Google Play Store
e iOS: Physical Web (http://adafru.it/ed]) in Apple's App Store

Codebase Revision: 0.4.7

Parameters: The URI to encode (ex. http://www.adafruit.com/blog (http://adafru.it/ei0))

Output: None of a valid URI was entered (length is acceptable, etc.).
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AT+BLEURIBEACON-=http://www.adafruit.com/blog
OK

# Reset to change the advertising data

ATZ

OK

If the supplied URI is too long you will get the following output:
AT+BLEURIBEACON-=http://www.adafruit.com/this/uri/is/too/long

URL is too long

ERROR

If the URI that you are trying to encode is too long, try using a shortening service like bit.ly, and encode the shortened URI.
UriBeacon should be considered deprecated as a standard, and EddyStone should be used for any future development. No further development
will happen in the Bluefruit LE firmware around UriBeacon.

Deprecated: AT+EDDYSTONEENABLE

This command will enable Eddystone (http://adafru.it/fSA) support on the Bluefruit LE module. Eddystone support must be enabled before the
other related commands can be used.

Codebase Revision: 0.6.6
Parameters: 1 or 0 (1 = enable, 0 = disable)
Output: The current state of Eddystone support if no parameters are provided (1 = enabled, 0 = disabled)

This command was removed in firmware 0.7.0 to avoid confusion. Use AT+EDDYSTONESERVICEEN in 0.7.0 and higher.

# Enable Eddystone support
AT+EDDYSTONEENABLE=1
OK

# Check the current Eddystone status on the module
AT+EDDYSTONEENABLE

1

OK

AT+EDDYSTONEURL

This command will set the URL for theEddystone-URL (http://adafru.it/fSB) protocol.
Codebase Revision: 0.6.6
Parameters:

e The URL to encode (mandatory)

e An optional second parameter indicates whether to continue advertising the Eddystone URL even when the peripheral is connected to a
central device

e Firmware 0.6.7 added an optional third parameter for the RSSI at 0 meters value. This should be measured by the end user by checking the
RSSI value on the receiving device at 1m and then adding 41 to that value (to compensate for the signal strength loss over 1m), so an RSSI
of -62 at 1m would mean that you should enter -21 as the RSSI at Om. Default value is -18dBm.

Output: Firmware <= 0.6.6: none. With firmware >=0.6.7 running this command with no parameters will return the current URL.
# Set the Eddystone URL to adafruit

AT+EDDYSTONEURL=http://www.adafruit.com

OK

# Set the Eddystone URL to adafruit and advertise it even when connected

AT+EDDYSTONEURL=http://www.adafruit.com,1
OK

AT+EDDYSTONECONFIGEN

This command causes the Bluefruit LE module to enable the Eddystone URL config service for the specified number of seconds.

This command should be used in combination with the Physical Web application from Google, available foAndroid (http://adafru.it/edi) or
iOS (http://adafru.it/edj). Run this command then select the 'Edit URL' option from the app to change the destination URL over the air.

Codebase Revision: 0.6.6
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Parameters: The number of seconds to advertised the config service UUID
Output: None

# Start advertising the Eddystone config service for 5 minutes (300s)
AT+EDDYSTONECONFIGEN=300
OK

AT+EDDYSTONESERVICEEN

Adds or removes the Eddystone service from the GATT table (requires a reset to take effect).
Codebase Revision: 0.7.0
Parameters: Whether or not the Eddystone service should be enabled or not, using on of the following values:

on
off
1
0

L]
L]
L]
L]

Output: If the command is executed with no parameters it will disable a numeric value indicating whether the service is enabled (1) or disabled (0).

You must perform a system reset for this command to take effect.

# Enable Eddystone service
AT+EddyStonServiceEn=on
OK

AT+EddyStonServiceEn=1
OK

# Disable Eddystone service
AT+EddyStonServiceEn=off
OK

AT+EddyStonServiceEn=0
OK

AT+EDDYSTONEBROADCAST

This command can be used to start of stop advertising the Eddystone payload using the URL stored in non-volatile memory (NVM).
Codebase Revision: 0.7.0
Parameters: Whether or not the payload should be broadcast, using one of the following values:

on
off
1
0

L]
L]
L]
L]

Output: If executed with no parameters, the current broadcast state will be displayed as a numeric value.

# Enable broadcasting current setting of EddyStone (stored previously on nvm)
AT+EddyStoneBroadcast=on
OK

AT+EddyStoneBroadcast=1
OK

# Disable broadcasting current setting of EddyStone (still stored on nvm)
AT+EddyStoneBroadcast=off
OK

AT+EddyStoneBroadcast=0
OK
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BLE Generic

The following general purpose BLE commands are available on Bluefruit LE modules:

AT+BLEPOWERLEVEL

Gets or sets the current transmit power level for the module's radio (higher transmit power equals better range, lower transmit power equals better
battery life).

Codebase Revision: 0.3.0
Parameters: The TX power level (in dBm), which can be one of the following values (from lowest to higher transmit power):

-40
-20
-16
12

e o o o o o o o

Output: The current transmit power level (in dBm)

The updated power level will take affect as soon as the command is entered. If the device isn't connected to another device, advertising will stop
momentarily and then restart once the new power level has taken affect.
# Get the current TX power level (in dBm)

AT+BLEPOWERLEVEL

0

OK

# Set the TX power level to 4dBm (maximum value)

AT+BLEPOWERLEVEL=4

OK

# Set the TX power level to -12dBm (better battery life)

AT+BLEPOWERLEVEL=-12

OK

# Set the TX power level to an invalid value

AT+BLEPOWERLEVEL=-3
ERROR

AT+BLEGETADDRTYPE

Gets the address type (for the 48-bit BLE device address).

Normally this will be '1' (random), which means that the module uses a 48-bit address that was randomly generated during the manufacturing
process and written to the die by the manufacturer.

Random does not mean that the device address is randomly generated every time, only that a one-time random number is used.
Codebase Revision: 0.3.0
Parameters: None

Output: The address type, which can be one of the following values:

e 0 = public

e 1 =random
AT+BLEGETADDRTYPE
1
OK

AT+BLEGETADDR
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Gets the 48-bit BLE device address.

Codebase Revision: 0.3.0

Parameters: None

Output: The 48-bit BLE device address in the following format: 'AA:BB:CC:DD:EE:FF'
AT+BLEGETADDR

E4:C6:C7:31:95:11
OK

AT+BLEGETPEERADDR

Gets the 48-bit address of the peer (central) device we are connected to.
Codebase Revision: 0.6.5
Parameters: None

Output: The 48-bit address of the connected central device in hex format. The command will returnERROR if we are not connected to a central
device.

Please note that the address returned by the central device is almost always a random value that will change over time, and this value should
generally not be trusted. This command is provided for certain edge cases, but is not useful in most day to day scenarios.

AT+BLEGETPEERADDR
48:B2:26:E6:C1:1D
OK

AT+BLEGETRSSI

Gets the RSSI value (Received Signal Strength Indicator), which can be used to estimate the reliability of data transmission between two devices
(the lower the number the better).

Codebase Revision: 0.3.0
Parameters: None
Output: The RSSI level (in dBm) if we are connected to a device, otherwise '0'

# Connected to an external device
AT+BLEGETRSSI

-46

OK

# Not connected to an external device
AT+BLEGETRSSI

0

OK
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BLE Services

The following commands allow you to interact with various GATT services present on Bluefruit LE modules when running in Command Mode.

AT+BLEUARTTX

This command will transmit the specified text message out via theUART Service (http://adafru.it/iCn) while you are running in Command Mode.
Codebase Revision: 0.3.0

Parameters: The message payload to transmit. The payload can be up to 240 characters (since AT command strings are limited to a maximum of
256 bytes total).

Output: This command will produce anERROR message if you are not connected to a central device, or if the internal TX FIFO on the Bluefruit
LE module is full.

As of firmware release 0.6.2 and higher, AT+BLEUARTTX can accept a limited set of escape code sequences:

\r = carriage return
\n = new line

\t = tab

\b = backspace

\\ = backward slash

As of firmware release 0.6.7 and higher, AT+BLEUARTTX can accept the following escape code sequence since AT+BLEUARTTX=? has a
specific meaning to the AT parser:

e \? = transmits a single question mark

You must be connected to another device for this command to execute

# Send a string when connected to another device
AT+BLEUARTTX=THIS IS A TEST
OK

# Send a string when not connected

AT+BLEUARTTX=THIS IS A TEST
ERROR

TX FIFO Buffer Handling

Starting with firmware version 0.6.7, when the TX FIFO buffer is full a 200ms blocking delay will be used to see if any free space becomes
available in the FIFO before returning ERROR. The exact process is detailed in the flow chart below:

( FIFO HANDLER

Colle 3
AT+BLELARTTX=DATA

peripheral
connected?

_‘m =
Isthe TXFIFO
full?

200mz for FIFO
space
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Note: The TX FIFO full check will happen for each GATT transaction (of up to 20 bytes of data each), so large data transfers may have multiple
200ms wait states.

You can use the AT+BLEUARTFIFO=TX (http://adafru.it/id3) command to check the size of the TX FIFO before sending data to ensure that you
have enough free space available in the buffer.

The TX FIFO has the following size, depending on the firmware version used:

e Firmware <=0.6.6: 160 characters wide
e Firmware >=0.6.7: 1024 characters wide

It IS possible with large data transfers that part of the payload can be transmitted, and the command can still produce an ERROR if the FIFO
doesn't empty in time in the middle of the payload transfer (since data is transmitted in maximum 20 byte chunks). If you need to ensure reliable
data transfer, you should always check the TX FIFO size before sending data, which you can do using the AT+BLEUARTFIFO command. If not
enough space is available for the entire payload, add a SW delay until enough space is available. Any single AT+BLEUARTTX command can fit
into the FIFO, but multiple large instances of this command may cause the FIFO to fill up mid transfer.

AT+BLEUARTRX

This command will dump the UART service (http://adafru.it/iCn)'s RX buffer to the display if any data has been received from from the UART
service while running in Command Mode. The data will be removed from the buffer once it is displayed using this command.

Any characters left in the buffer when switching back to Data Mode will cause the buffered characters to be displayed as soon as the mode switch
is complete (within the limits of available buffer space, which is 1024 bytes on current black 32KB SRAM devices, or 160 bytes for the blue first
generation BLEFriend board based on 16KB SRAM parts).

Codebase Revision: 0.3.0
Parameters: None
Output: The RX buffer's content if any data is available, otherwise nothing.

You can also use the AT+BLEUARTFIFO=RX command to check if any incoming data is available or not.

# Command results when data is available
AT+BLEUARTRX

Sent from Android

OK

# Command results when no data is available
AT+BLEUARTRX
OK

AT+BLEUARTFIFO

This command will return the free space available in the BLE UART TX and RX FIFOs. If you are transmitting large chunks of data, you may want
to check if you have enough free space in the TX FIFO before sending, keeping in mind that individual GATT packets can contain up to 20 user
bytes each.

Codebase Revision: 0.6.7

Parameters: Running this command with no parameters will return two comma-separated values indicating the free space in the TX buffer,
following by the RX buffer. To request a specific buffer, you can execute the command with either a "TX" or "RX" value (For example:
"AT+BLEUARTFIFO=TX").

Output: The free space remaining in the TX and RX FIFO buffer if no parameter is present, otherwise the free space remaining in the specified
FIFO buffer.

AT+BLEUARTFIFO
1024,1024
OK

AT+BLEUARTFIFO=TX
1024
OK

AT+BLEUARTFIFO=RX
1024
OK

AT+BLEKEYBOARDEN
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This command will enable GATT over HID (GoH) keyboard support, which allows you to emulate a keyboard on supported iOS and Android
devices. By default HID keyboard support is disabled, so you need to set BLEKEYBOARDEN to 1 and then perform a system reset before the
keyboard will be enumerated and appear in the Bluetooth preferences on your phone, where if can be bonded as a BLE keyboard.

Codebase Revision: 0.5.0
Parameters: 1 or 0 (1 = enable, 0 = disable)
Output: None

As of firmware version 0.6.6 this command is now an alias for AT+BLEHIDEN

You must perform a system reset (ATZ) before the changes take effect!

Before you can use your HID over GATT keyboard, you will need to bond your mobile device with the Bluefruit LE module in the Bluetooth
preferences panel.

# Enable BLE keyboard support then reset
AT+BLEKEYBOARDEN=1

OK

ATZ

OK

# Disable BLE keyboard support then reset
AT+BLEKEYBOARDEN=0
OK

ATZ
OK

AT+BLEKEYBOARD

Sends text data over the BLE keyboard interface (if it has previously been enabled via AT+BLEKEYBOARDEN).
Any valid alpha-numeric character can be sent, and the following escape sequences are also supported:

e \r- Carriage Return
e \n - Line Feed

e \b - Backspace

e \t-Tab

e \\- Backslash

As of version 0.6.7 you can also use the following escape code when sending a single character ('AT+BLEKEYBOARD="?' has another meaning
for the AT parser):

e \? - Question mark
Codebase Revision: 0.5.0
Parameters: The text string (optionally including escape characters) to transmit
Output: None
# Send a URI with a new line ending to execute in Chrome, etc.
AT+BLEKEYBOARD=http://www.adafruit.com\rin
OK
# Send a single question mark (special use case, 0.6.7+)

AT+BLEKEYBOARD=\?
OK

AT+BLEKEYBOARDCODE

Sends a raw hex sequence of USB HID keycodes to the BLE keyboard interface including key modifiers and up to six alpha-numeric characters.
This command accepts the following ascii-encoded HEX payload, matching the way HID over GATT sends keyboard data:

« Byte 0: Modifier
o Byte 1: Reserved (should always be 00)
e Bytes 2..7: Hexadecimal values for ASCll-encoded characters (if no character is used you can enter '00' or leave trailing characters empty)

After a keycode sequence is sent with the AT+BLEKEYBOARDCODE command,you must send a second AT+BLEKEYBOARDCODE
command with at least two 00 characters to indicate the keys were released!

Modifier Values
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The modifier byte can have one or more of the following bits set:

Bit 0 (0x01): Left Control
Bit 1 (0x02): Left Shift

Bit 2 (0x04): Left Alt

Bit 3 (0x08): Left Window
Bit 4 (0x10): Right Control
Bit 5 (0x20): Right Shift
Bit 6 (0x40): Right Alt

Bit 7 (0x80): Right Window

e o o o o o o o

Codebase Revision: 0.5.0
Parameters: A set of hexadecimal values separated by a hyphen (*-'). Note that these are HID scan code values, not standard ASCII values!
Output: None

HID key code values don't correspond to ASCII key codes! For example, 'a' has an HID keycode value of '04', and there is no keycode for an upper
case 'A' since you use the modifier to set upper case values. For details, google 'usb hid keyboard scan codes', and see the example below.

A list of HID keyboard codes can be found here (http://adafru.it/cQV) (see section 7).

# send 'abc' with shift key --> 'ABC'
AT+BLEKEYBOARDCODE=02-00-04-05-06-00-00
OK

# Indicate that the keys were released (mandatory!)
AT+BLEKEYBOARDCODE=00-00

OK

AT+BLEHIDEN

This command will enable GATT over HID (GoH) support, which allows you to emulate a keyboard, mouse or media controll on supported iOS,
Android, OSX and Windows 10 devices. By default HID support is disabled, so you need to set BLEHIDEN to 1 and then perform a system reset
before the HID devices will be enumerated and appear in on your central device.

Codebase Revision: 0.6.6
Parameters: 1 or 0 (1 = enable, 0 = disable)
Output: None

You normally need to 'bond' the Bluefruit LE peripheral to use the HID commands, and the exact bonding process will change from one operating
system to another.

If you have previously bonded to a device and need to clear the bond, you can run the AT+FACTORYRESET command which will erase all stored
bond data on the Bluefruit LE module.

# Enable GATT over HID support on the Bluefruit LE module

AT+BLEHIDEN=1

OK

# Reset so that the changes take effect

ATZ
OK

AT+BLEHIDMOUSEMOVE

Moves the HID mouse or scroll wheen position the specified number of ticks.

All parameters are signed 8-bit values (-128 to +127). Positive values move to the right or down, and origin is the top left corner.
Codebase Revision: 0.6.6

Parameters: X Ticks (+/-), Y Ticks (+/-), Scroll Wheel (+/-), Pan Wheel (+/-)

Output: None

# Move the mouse 100 ticks right and 100 ticks down

AT+BLEHIDMOUSEMOVE=100,100

OK

# Scroll down 20 pixels or lines (depending on context)

AT+BLEHIDMOUSEMOVE-=,,20,
OK
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# Pan (horizontal scroll) to the right (exact behaviour depends on OS)
AT+BLEHIDMOUSEMOVE=0,0,0,100

AT+BLEHIDMOUSEBUTTON

Manipulates the HID mouse buttons via the specific string(s).
Codebase Revision: 0.6.6
Parameters: Button Mask String [L][R][M][B][F], Action [PRESS][CLICK][DOUBLECLICK][HOLD]

L = Left Button

R = Right Button

M = Middle Button

B = Back Button

F = Forward Button

If the second parameter (Action) is "HOLD", an optional third parameter can be passed specifying how long the button should be held in
milliseconds.

e o o o o o

Output: None

# Double click the left mouse button
AT+BLEHIDMOUSEBUTTON=L,doubleclick
OK

# Press the left mouse button down, move the mouse, then release L
# This is required to perform 'drag' then stop type operations
AT+BLEHIDMOUSEBUTTON=L

OK

AT+BLEHIDMOUSEMOVE=-100,50

OK

AT+BLEHIDMOUSEBUTTON=0

OK

# Hold the backward mouse button for 200 milliseconds (OS dependent)
AT+BLEHIDMOUSEBUTTON=B,hold,200
OK

AT+BLEHIDCONTROLKEY

Sends HID media control commands for the bonded device (adjust volume, screen brightness, song selection, etc.).
Codebase Revision: 0.6.6

Parameters: The HID control key to send, followed by an optional delay in ms to hold the button

The control key string can be one of the following values:

e System Controls (works on most systems)
o BRIGHTNESS+
o BRIGHTNESS-

e Media Controls (works on most systems)
o PLAYPAUSE
o MEDIANEXT
o MEDIAPREVIOUS
o MEDIASTOP

e Sound Controls (works on most systems)
o VOLUME

MUTE

BASS

TREBLE

BASS_BOOST

VOLUME+

VOLUME-

BASS+

BASS-

TREBLE+
o TREBLE-

e Application Launchers (Windows 10 only so far)
o EMAILREADER

0o 0 0o o o o o o o
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o CALCULATOR
o FILEBROWSER
o Browser/File Explorer Controls (Firefox on Windows/Android only)
SEARCH
HOME
BACK
FORWARD
STOP
REFRESH
BOOKMARKS

0o 0 o o o o o

You can also send a raw 16-bit hexadecimal value in the '0xABCD' format. A full list of 16-bit 'HID Consumer Control Key Codes' can be found
here (http://adafru.it/cQV)(see section 12).

Output: Normally none.

If you are not bonded and connected to a central device, this command will return ERROR. Make sure you are connected and HID support is
enabled before running these commands.

# Toggle the sound on the bonded central device
AT+BLEHIDCONTROLKEY=MUTE

OK

# Hold the VOLUME+ key for 500ms
AT+BLEHIDCONTROLKEY=VOLUME+,500

OK

# Send a raw 16-bit Consumer Key Code (0x006F = Brightness+)

AT+BLEHIDCONTROLKEY=0x006F
OK

AT+BLEHIDGAMEPAD

Sends a specific HID gamepad payload out over BLE
Codebase Revision: 0.7.0
Parameters: The following comma-separated parameters are available:

e x: LEFT, RIGHT: If X=-1 then 'LEFT" is pressed, if X=1 then 'RIGHT" is pressed, if X=0 then neither left nor right are pressed
e y: UP, DOWN: If Y=-1 then 'UP' is pressed, if Y=1 then 'DOWN' is pressed, if Y=0 then neither up nor down are pressed
e buttons: 0x00-0xFF, which is a bit mask for 8 button 0-7

Output: Nothing

Note: You need to send both 'press' and 'release' events for each button, otherwise the system will think that the button is still pressed until a
release state is received.

# Press 'RIGHT" and 'Button0' at the same time
AT+BLEHIDGAMEPAD=1,0,0x01

# Press 'UP' and 'Button1' + 'ButtonQ' at the same time
AT+BLEHIDGAMEPAD=0,-1,0x03

AT+BLEMIDIEN

Enables or disables the BLE MIDI service.
Codebase Revision: 0.7.0

Parameters: State, which can be one of:
L]
L]
L]
L]

Output: If executed with no parameters, it will return the current state of the MIDI service as an integer indicating if it is enabled (1) or disabled (0).

Note: This command will require a reset to take effect.

# Check the current state of the MIDI service
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AT+BLEMIDIEN

1

OK

# Enable the MIDI Service

AT+BLEMIDIEN=1
OK

AT+BLEMIDIRX

Reads an incoming MIDI character array from the buffer.
Codebase Revision: 0.7.0

Parameters: None

Output: The midi event in byte array format
AT+BLEMIDIRX

90-3C-7F
OK

AT+BLEMIDITX

Sends a MIDI event to host.
Codebase Revision: 0.7.0
Parameters: The MIDI event in hex array format, which can be either:

e A series of full MIDI events (up to 4 events)
e Exactly 1 full MIDI event + several running events without status (up to 7)

Output: None

# Send 1 event (middle C with max velocity)
AT+BLEMIDITX=90-3C-7F

OK

# Send 2 events
AT+BLEMIDITX=90-3C-7F-A0-3C-7F

OK

# Send 1 full event + running event

AT+BLEMIDITX=90-3C-7F-3C-7F
OK

AT+BLEBATTEN

Enables the Battery Service following the definition from the Bluetooth SIG.
Codebase Revision: 0.7.0
Parameters: Whether the battery service should be enabled, via on of the following values:

on
off
1
0

L]
L]
L]
L]

Output: If executed with no parameters, a numeric value will be returned indicating whether the battery service is enabled (1) or disabled (0).

This command requires a system reset to take effect.

# Enable the Battery Service
AT+BLEBATTEN=1
OK

AT+BLEBATTVAL

Sets the current battery level in percentage (0..100) for the Battery Service (if enabled).

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industries . .
microcontroller-usb-bluetooth-le-in-one

Page 78 of 113



Codebase Revision: 0.7.0
Parameters: The percentage for the battery in the range of 0..100.
Output: If executed with no parameters, the current battery level stored in the characteristic.

# Set the battery level to 72%
AT+BLEBATTVAL=72
OK
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BLE GAP

GAP (http://adafru.it/iCo), which stands for the Generic Access Profile, governs advertising and connections with Bluetooth Low Energy devices.
The following commands can be used to configure the GAP settings on the BLE module.

You can use these commands to modify the advertising data (for ex. the device name that appears during the advertising process), to retrieve
information about the connection that has been established between two devices, or the disconnect if you no longer wish to maintain a connection.

AT+GAPCONNECTABLE

This command can be used to prevent the device from being 'connectable’.
Codebase Revision: 0.7.0
Parameters: Whether or not the device should advertise itself as connectable, using one of the following values:

e yes
e NO
o 1
e 0
Output: The 'connectable’ state of the device if no parameter is provided
# Make the device non-connectable (advertising only)
AT+GAPCONNECTABLE=0
OK
# Check the current connectability status
AT+GAPCONNECTABLE

1
OK

AT+GAPGETCONN

Diplays the current connection status (if we are connected to another BLE device or not).
Codebase Revision: 0.3.0

Parameters: None

Output: 1 if we are connected, otherwise 0

# Connected

AT+GAPGETCONN

oK

# Not connected

AT+GAPGETCONN

0
OK

AT+GAPDISCONNECT

Disconnects to the external device if we are currently connected.
Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+GAPDISCONNECT
OK

AT+GAPDEVNAME
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Gets or sets the device name, which is included in the advertising payload for the Bluefruit LE module
Codebase Revision: 0.3.0
Parameters:

* None to read the current device name
e The new device name if you want to change the value

Output: The device name if the command is executed in read mode

Updating the device name will persist the new value to non-volatile memory, and the updated name will be used when the device is reset. To reset
the device to factory settings and clean the config data from memory run the AT+FACTORYRESET command.

# Read the current device name

AT+GAPDEVNAME

UART

OK

# Update the device name to 'BLEFriend'

AT+GAPDEVNAME=BLEFriend

OK

# Reset to take effect

ATZ
OK

AT+GAPDELBONDS

Deletes and bonding information stored on the Bluefruit LE module.
Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+GAPDELBONDS
OK

AT+GAPINTERVALS

Gets or sets the various advertising and connection intervals for the Bluefruit LE module.

Be extremely careful with this command since it can be easy to cause problems changing the intervals, and depending on the values selected
some mobile devices may no longer recognize the module or refuse to connect to it.

Codebase Revision: 0.3.0
Parameters: If updating the GAP intervals, the following comma-separated values can be entered:

Minimum connection interval (in milliseconds)

Maximum connection interval (in milliseconds)

Fast Advertising interval (in milliseconds)

Fast Advertising timeout (in seconds)

>= 0.7.0: Low power advertising interval (in milliseconds), default = 417.5 ms

e o o o o

To save power, the Bluefruit modules automatically drop to a lower advertising rate after 'fast advertising timeout' seconds. The default value is 30
seconds (‘Fast Advertising Timeout'). The low power advertising interval is hard-coded to approximately 0.6s in firmware < 0.7.0. Support to
control the low power interval was added in the 0.7.0 firmware release via an optional fifth parameter.

Please note the following min and max limitations for the GAP parameters:

Absolute minimum connection interval: 10ms

Absolute maximum connection interval: 4000ms

Absolute minimum fast advertising interval: 20ms

Absolute maximum fast advertisting interval: 10240ms
Absolute minimum low power advertising intervat 20ms
Absolute maximum low power advertising interval: 10240ms

e o o o o o

If you only wish to update one interval value, leave the other comma-separated values empty (ex. ',,110," will only update the third value,
advertising interval).
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Output: If reading the current GAP interval settings, the following comma-separated information will be displayed:

e Minimum connection interval (in milliseconds)
e Maximum connection interval (in milliseconds)
e Advertising interval (in milliseconds)
e Advertising timeout (in milliseconds)

Updating the GAP intervals will persist the new values to non-volatile memory, and the updated values will be used when the device is reset. To
reset the device to factory settings and clean the config data from memory run the AT+FACTORYRESET command.

# Read the current GAP intervals
AT+GAPINTERVALS

20,100,100,30

# Update all values
AT+GAPINTERVALS=20,200,200,30
OK

# Update only the advertising interval

AT+GAPINTERVALS=,,150,
OK

AT+GAPSTARTADV

Causes the Bluefruit LE module to start transmitting advertising packets if this isn't already the case (assuming we aren't already connected to an
external device).

Codebase Revision: 0.3.0

Parameters: None

Output: None

# Command results when advertising data is not being sent
AT+GAPSTARTADV

OK

# Command results when we are already advertising
AT+GAPSTARTADV

ERROR

# Command results when we are connected to another device

AT+GAPSTARTADV
ERROR

AT+GAPSTOPADYV

Stops advertising packets from being transmitted by the Bluefruit LE module.
Codebase Revision: 0.3.0

Parameters: None

Output: None

AT+GAPSTOPADV
OK

AT+GAPSETADVDATA

Sets the raw advertising data payload to the specified byte array (overriding the normal advertising data), following the guidelines in th8luetooth
4.0 or 4.1 Core Specification (http:/adafru.it/ddd).

In particular, Core Specification Supplement (CSS) v4 contains the details on common advertising data fields like 'Flags' (Part A, Section 1.3)
and the various Service UUID lists (Part A, Section 1.1). A list of all possible GAP Data Types is available on the Bluetooth SIG's Generic Access
Profile (http://adafru.it/cYs) page.

The Advertising Data payload consists of Generic Access Profile (http://adafru.it/cYs) data that is inserted into the advertising packet in the
following format: [U8:LEN] [U8:Data Type Value] [n:Value]

WARNING: This command requires a degree of knowledge about the low level details of the Bluetooth 4.0 or 4.1 Core Specification, and should
only be used by expert users. Misuse of this command can easily cause your device to be undetectable by central devices in radio range.
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WARNING: This command will override the normal advertising payload and may prevent some services from acting as expected.
To restore the advertising data to the normal default values use the AT+FACTORYRESET command.

For example, to insert the 'Flags' Data Type (Data Type Value 0x01), and set the value to 0x06/0b00000110 (BR/EDR Not Supported and LE
General Discoverable Mode) we would use the following byte array:

02-01-06

e 0x02 indicates the number of bytes in the entry

e 0x01 is the 'Data Type Value (http://adafru.it/cYs)' and indicates that this is a Flag'

e 0x06 (0b00000110) is the Flag value, and asserts the following fields (see Core Specification 4.0, Volume 3, Part C, 18.1):
o LE General Discoverable Mode (i.e. anyone can discover this device)
o BR/EDR Not Supported (i.e. this is a Bluetooth Low Energy only device)

If we also want to include two 16-bit service UUIDs in the advertising data (so that listening devices know that we support these services) we could
append the following data to the byte array:

05-02-0D-18-0A-18

e 0x05 indicates that the number of bytes in the entry (5)

e 0x02 is the 'Data Type Value (http://adafru.it/cYs)' and indicates that this is an Incomplete List of 16-bit Service Class UUIDs

o 0x0D 0x18 is the first 16-bit UUID (which translates to0x180D, corresponding to the Heart Rate Service (http://adafru.it/ddB)).

o 0xO0A 0x18 is another 16-bit UUID (which translates toOx180A, corresponding to the Device Information Service (http://adafru.it/ecj)).

Including the service UUIDs is important since some mobile applications will only work with devices that advertise a specific service UUID in the
advertising packet. This is true for most apps from Nordic Semiconductors, for example.

Codebase Revision: 0.3.0

Parameters: The raw byte array that should be inserted into the advertising data section of the advertising packet, being careful to stay within the
space limits defined by the Bluetooth Core Specification.

Response: None

# Advertise as Discoverable and BLE only with 16-bit UUIDs 0x180D and 0x180A
AT+GAPSETADVDATA=02-01-06-05-02-0d-18-0a-18
OK

The results of this command can be seen in the screenshot below, taken from a sniffer analyzing the advertising packets in Wireshark. The
advertising data payload is higlighted in blue in the raw byte array at the bottom of the image, and the packet analysis is in the upper section:

= Bluetooth Low Energy Link Layer
Access Address: @xBe89bedb
P Packet Header: 0x0f40 (PDU Type: ADV_IND, TxAdd=false, RxAdd=false)
Advertising Address: ed:c6:c7:31:95:11 (ed:c6:c7:31:95:11)

-
= Flags

Length: 2

Type: Flags (0xel)

008, .... = Reserved: @x00
.8 .... = Simultanecus LE and BR/EDR to Same Device Capable (Host): false (@x08)
. B... = Simultaneous LE and BR/EDR to Same Device Capable (Controller): false (8x0@)

.1.. = BR/EDR Not Supported: true (8x01)

.... ..1l. = LE General Discoverable Mode: true (8x81)
....... © = LE Limited Discoverable Mode: false (0x08)
= 16-bit Service Class UUIDs (incomplete)

Length: 5
Type: 16-bit Service Class UUIDs (incomplete) (0x02)
UUID 16: Heart Rate (©x180d)
UUID 16: Device Information (@x188a)

P CRC: 0x93b900

0000 00 06 22 01 8b 17 06 Ga ©1 26 2b 00 00 97 02 0O sauisias alibiuuas
0610 08 .
0020
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BLE GATT

GATT (http://adafru.it/iCp), which standards for the Generic ATTribute Profile, governs data organization and data exchanges between connected
devices. One device (the peripheral) acts as a GATT Server, which stores data in Attribute records, and the second device in the connection (the
central) acts as a GATT Client, requesting data from the server whenever necessary.

The following commands can be used to create custom GATT services and characteristics on the BLEFriend, which are used to store and
exchange data.

Please note that any characteristics that you define here will automatically be saved to non-volatile FLASH config memory on the device and re-
initialised the next time the device starts.

You need to perform a system reset via 'ATZ' before most of the commands below will take effect!

GATT Limitations

The commands below have the following limitations due to SRAM and resource availability, which should be kept in mind when creating or
working with customer GATT services and characteristics.

These values apply to firmware 0.7.0 and higher:

Maximum number of services: 10

Maximum number of characteristics: 30

Maximum buffer size for each characteristic: 32 bytes
Maximum number of CCCDs: 16

L]
L]
L]
L]
If you want to clear any previous config value, enter the AT+FACTORYRESET' command before working on a new peripheral configuration.

AT+GATTCLEAR

Clears any custom GATT services and characteristics that have been defined on the device.
Codebase Revision: 0.3.0

Parameters: None

Response: None

AT+GATTCLEAR
OK

AT+GATTADDSERVICE

Adds a new custom service definition to the device.
Codebase Revision: 0.3.0

Parameters: This command accepts a set of comma-separated key-value pairs that are used to define the service properties. The following key-
value pairs can be used:

e UUID: The 16-bit UUID to use for this service. 16-bit values should be in hexadecimal format (0x1234).
e UUID128: The 128-bit UUID to use for this service. 128-bit values should be in the following format: 00-11-22-33-44-55-66-77-88-99-AA-BB-
CC-DD-EE-FF

Response: The index value of the service in the custom GATT service lookup table. (It's important to keep track of these index values to work with
the service later.)

Note: Key values are not case-sensitive
Only one UUID type can be entered for the service (either UUID or UUID128)

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F
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1
OK

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1

OK

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
1

OK

# Add a custom characteristic to the above service (making sure that there

#is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
1

OK

AT+GATTADDCHAR

Adds a custom characteristic to the last service that was added to the peripheral (via AT+GATTADDSERVICE).

AT+GATTADDCHAR must be run AFTER AT+GATTADDSERVICE, and will add the new characteristic to the last service definition that was
added.

As of version 0.6.6 of the Bluefruit LE firmware you can now use custom 128-bit UUIDs with this command. See the example at the bottom of this
command description.

Codebase Revision: 0.3.0

Parameters: This command accepts a set of comma-separated key-value pairs that are used to define the characteristic properties. The following
key-value pais can be used:

e UUID: The 16-bit UUID to use for the characteristic (which will be insert in the 3rd and 4th bytes of the parent services 128-bit UUID). This
value should be entered in hexadecimal format (ex. 'UUID=0x1234"). This value must be unique, and should not conflict with bytes 3+4 of the
parent service's 128-bit UUID.

o PROPERTIES: The 8-bit characteristic properties field, as defined by the Bluetooth SIG. The following values can be used:

o 0x02 - Read

o 0x04 - Write Without Response
o 0x08 - Write

o 0x10 - Notify

o 0x20 - Indicate

o MIN_LEN: The minimum size of the values for this characteristic (in bytes, min = 1, max = 20, default = 1)

o MAX_LEN: The maximum size of the values for the characteristic (in bytes, min = 1, max = 20, default = 1)

e VALUE: The initial value to assign to this characteristic (within the limits of 'MIN_LEN' and 'MAX_LEN"). Value can be an integer ("-100",
"27"), a hexadecimal value ("0OxABCD"), a byte array ("aa-bb-cc-dd") or a string ("GATT!").

e >=0.7.0 - DATATYPE: This argument indicates the data type stored in the characteristic, and is used to help parse data properly. It can be
one of the following values:

o AUTO (0, default)
o STRING (1)
o BYTEARRAY (2)
o INTEGER (3)
e >=0.7.0 - DESCRIPTION: Adds the specified string as the characteristic description entry
e >=0.7.0 - PRESENTATION: Adds the specified value as the characteristic presentation format entry

Response: The index value of the characteristic in the custom GATT characteristic lookup table. (It's important to keep track of these
characteristic index values to work with the characteristic later.)

Note: Key values are not case-sensitive
Make sure that the 16-bit UUID is unique and does not conflict with bytes 3+4 of the 128-bit service UUID

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

OK
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# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1

OK

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
1

OK

# Add a custom characteristic to the above service (making sure that there

#is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
1

OK

Version 0.6.6 of the Bluefruit LE firmware added the ability to use a newUUID128' flag to add custom 128-bit UUIDs that aren't related to the
parent service UUID (which is used when passing the 16-bit 'UUID' flag).

To specify a 128-bit UUID for your customer characteristic, enter a value resembling the following syntax:

# Add a custom characteristic to the above service using a

# custom 128-bit UUID
AT+GATTADDCHAR=UUID128=00-11-22-33-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
1

OK

Version 0.7.0 of the Bluefruit LE firmware added the newDESCRIPTION and PRESENTATION keywoards, corresponding the the GATT
Characteristic User Description (http://adafru.it/olA) and the GATT Characteristic Presentation Format (http://adafru.it/olB) Descriptors.

The DESCRIPTION field is a string that contains a short text description of the characteristic. Some apps may not display this data, but it should
be visible using something like the Master Control Panel application from Nordic on iOS and Android.

The PRESENTATION field contains a 7-byte payload that encapsulates the characteristic presentation format data. It requires a specific set of
bytes and values to work properly. See the following link for details on how to format the

payload: https://developer.bluetooth.org/gatt/descriptors/Pages/DescriptorViewer.aspx?
u=org.bluetooth.descriptor.gatt.characteristic_presentation_format.xml (http://adafru.it/olB)

The following example shows how you might use both of these new fields:

AT+GATTADDCHAR=UUID=0x2A37, PROPERTIES=0x10, MIN_LEN=2, MAX_LEN=3, VALUE=00-40,
DESCRIPTION=HRM Measurement, PRESENTATION=17-00-AC-27-01-00-00

For the Characteristic Presentation Format we have:

e Format = IEEE-11073 32-bit FLOAT (Decimal 23, Hex 0x17)

e Exponent = 0/None

e Unit = Thermodynamic temperature: Degrees Fahrenheit (0x27AC) -Bluetooth LE Unit List (http://adafru.it/olD)
e Namespace = Bluetooth SIG Assigned Number (0x01)

e Description = None (0x0000)

The results from Nordic's Master Control Panel app can be seen below:

Actons
| Dacomect | [Bond | [Updete | | Discaversenvces | | Ensble senices | [ DFU_|
Service Discavesy
Schtware Revision Strrg, Valus: 30-26-37-26-30-20-20- 2044 75 6E-20. 32 35 2032303136
Charpctenstic Doclaration, Vako: (2-1C-00-26-24. Properties: Rlsad. Charsctertstic LUUID: (2426
Femiare Revision Strng, Vakue: 53:31:31:30.20:38 26-30-26-30.2C20-30-26.32

=X, 3 . Vaoe: 02-1E-00-27-24. Propeties: Read, Charactenistic UUID: (k2427
Hardware Revision Stng, Valoe: 5145-41-42-4131-20

P . Value: SE-CA-DC-28-0E-E5-AS-E00-F I-AT-ES-01-D0-406E, UART aver BLE B5A3FI50-EIAS-ESOEMDCCATE)

- Charpctenistic Deciarstion. Vahoe: 10:21-00-5€ CADC 24-06 ES-AS-E0-93-F3A-85-03-00-40-6E Proprties: Moty Ch uuib: BEA3-F393-E0A E24OCCASE
UART TX, Ve
CharacteristiclserDescription, Vslue: 54-58-44, UserDescrption: TXD
Charet

onfiguration. Value: 00-00. Ch L Heew (00000}
CharactensticDeclaration, Value: 0C-25-00-9E-CA-DC-24-0E-E5-AS-E FIATES 40-EE,
UART RX. (No vaiues read)
Charmectenista: UserDescrigtion. Value: 52:50-44, UserDesception: RXD
= PrmaryService, Value: 00-18, Heart Rate {1800)
=-Ch i . Visho: 10 T-2A, Propedies: Notly, Chiracterstic UUID: (x2A37
Heat Rate Measurement, Value: 00-60
CharactensticUserDescription, Value: 48-52-40-204D-6561-73-75-T2-65-6D-65-6E-
ChereCharsctersticConfiouration. Valus: 00-00. ChamctessticConfiguration Bt

sponse, Wite, Charactenstic UUID: n6E400002-B5A3-F193-E0#

-74, UserDescrption: HFRM Measurement
00000}

| Charactesistc Format, Value: 17-00-AC-27-01-00-00, Format: Roat, Exponent: 0, Uink: (c27AC. Name Space: Oc) 1. Descrption: (k0000
= Charactenstic Declaration, Value: (2-26-00-38-2A. Propeies: Read, Charactenstic UUID: x2A38
Heaa Rate Sensor Location. Vaka: 03 -

Fosbute vokot

AT+GATTCHAR
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Gets or sets the value of the specified custom GATT characteristic (based on the index ID returned when the characteristic was added to the

system via AT+GATTADDCHAR).

Codebase Revision: 0.3.0

Parameters: This function takes one or two comma-separated functions (one parameter = read, two parameters = write).

e The first parameter is the characteristic index value, as returned from the AT+GATTADDCHAR function. This parameter is always required,

and if no second parameter is entered the current value of this characteristic will be returned.

e The second (optional) parameter is the new value to assign to this characteristic (within the MIN_SIZE and MAX_SIZE limits defined when

creating it).

Response: If the command is used in read mode (only the characteristic index is provided as a value), the response will display the current value
of the characteristics. If the command is used in write mode (two comma-separated values are provided), the characteristics will be updated to

use the provided value.

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

OK

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1

OK

# Read the battery measurement characteristic (index ID = 1)
AT+GATTCHAR=1

0x64

OK

# Update the battery measurement characteristic to 32 (hex 0x20)
AT+GATTCHAR=1,32
OK

# Verify the previous write attempt
AT+GATTCHAR=1

0x20

OK

AT+GATTLIST

Lists all custom GATT services and characteristics that have been defined on the device.
Codebase Revision: 0.3.0

Parameters: None

Response: A list of all custom services and characteristics defined on the device.

# Clear any previous custom services/characteristics
AT+GATTCLEAR
OK

# Add a battery service (UUID = 0x180F) to the peripheral
AT+GATTADDSERVICE=UUID=0x180F

1

OK

# Add a battery measurement characteristic (UUID = 0x2A19), notify enabled
AT+GATTADDCHAR=UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,VALUE=100
1

OK

# Add a custom service to the peripheral
AT+GATTADDSERVICE=UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
2

OK

# Add a custom characteristic to the above service (making sure that there

#is no conflict between the 16-bit UUID and bytes 3+4 of the 128-bit service UUID)
AT+GATTADDCHAR=UUID=0x0002,PROPERTIES=0x02,MIN_LEN=1,VALUE=100
2

OK
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# Get a list of all custom GATT services and characteristics on the device

AT+GATTLIST

ID=01,UUID=0x180F
ID=01,UUID=0x2A19,PROPERTIES=0x10,MIN_LEN=1,MAX_LEN=1,VALUE=0x64

ID=02,UUID=0x11, UUID128=00-11-00-11-44-55-66-77-88-99-AA-BB-CC-DD-EE-FF
ID=02,UUID=0x02,PROPERTIES=0x02,MIN_LEN=1,MAX_LEN=1,VALUE=0x64

OK

AT+GATTCHARRAW

This read only command reads binary (instead of ASCII) data from a characteristic. It is non-printable but has less overhead and is easier when
writing libraries in Arduino.

Codebase Revision: 0.7.0
Parameters: The numeric ID of the characteristic to display the data for
Output: Binary data corresponding to the specified characteristic.

Note: This is a specialized command and no NEWLINE is present at the end of the command!
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Debug

The following debug commands are available on Bluefruit LE modules:

Use these commands with care since they can easily lead to a HardFault error on the ARM core, which will cause the device to stop responding.

AT+DBGMEMRD

Displays the raw memory contents at the specified address.
Codebase Revision: 0.3.0
Parameters: The following comma-separated parameters can be used with this command:

e The starting address to read memory from (in hexadecimal form, with or without the leading '0x")
e The word size (can be 1, 2, 4 or 8)
e The number of words to read

Output: The raw memory contents in hexadecimal format using the specified length and word size (see examples below for details)

# Read 12 1-byte values starting at 0x10000009
AT+DBGMEMRD=0x10000009,1,12

FF FF FF FF FF FF FF 00 04 00 00 00

OK

# Try to read 2 4-byte values starting at 0x10000000
AT+DBGMEMRD=0x10000000,4,2

55AA55AA 55AA55AA

OK

# Try to read 2 4-byte values starting at 0x10000009

# This will fail because the Cortex MO can't perform misaligned
# reads, and any non 8-bit values must start on an even address
AT+DBGMEMRD=0x10000009,4,2

MISALIGNED ACCESS
ERROR

AT+DBGNVMRD

Displays the raw contents of the config data section of non-volatile memory
Codebase Revision: 0.3.0

Properties: None

Output: The raw config data from non-volatile memory

AT+DBGNVMRD
FE CA 38 05 00 03 00 00 01 12 01 00 55 41 52 54 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 14 00 64 00 64 00 1E 00 00 00 00 00 00 |
OK

AT+DBGSTACKSIZE

Returns the current stack size, to help detect stack overflow or detect stack memory usage when optimising memory usage on the system.
Codebase Revision: 0.4.7

Parameters: None

Output: The current size of stack memory in bytes

AT+DBGSTACKSIZE

1032
OK

AT+DBGSTACKDUMP
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Dumps the current stack contents. Unused sections of stack memory are filled with '0XCAFEFOOQOD' to help determine where stack usage stops.

This command is purely for debug and development purposes.

Codebase Revision: 0.4.7

Parameters: None

Output: The memory contents of the entire stack region

AT+DBGSTACKDUMP

0x20003800:
0x20003810:
0x20003820:
0x20003830:
0x20003840:
0x20003850:
0x20003860:
0x20003870:
0x20003880:
0x20003890:
0x200038A0:
0x200038B0:
0x200038C0:
0x200038D0:
0x200038EO0:
0x200038FO0:

0x20003900:
0x20003910:
0x20003920:
0x20003930:
0x20003940:
0x20003950:
0x20003960:
0x20003970:
0x20003980:
0x20003990:

0x200039A0:
0x200039B0:
0x200039C0:
0x200039D0:
0x200039EO0:

0x200039FO0:

0x20003A00:
0x20003A10:
0x20003A20:
0x20003A30:
0x20003A40:
0x20003A50:
0x20003A60:
0x20003A70:
0x20003A80:
0x20003A90:
0x20003AA0:
0x20003ABO:
0x20003ACO0:
0x20003ADO:
0x20003AEQ:

0x20003AF0

0x20003BB0

0x20003BEO
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CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEFO0D
CAFEF00D CAFEFO0D CAFEF00D CAFEFO0D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEFO0D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEFO0D
CAFEF00D CAFEFO0D CAFEF00D CAFEFO0D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEFO0D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEFO0D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D

: CAFEF00D CAFEF00D CAFEFO0D CAFEF00D
0x20003B00:
0x20003B10:
0x20003B20:
0x20003B30:
0x20003B40:
0x20003B50:
0x20003B60:
0x20003B70:
0x20003B80:
0x20003B90:
0x20003BA0:

CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEFO0D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D

: CAFEFOOD CAFEF00D CAFEFO0D CAFEF00D
0x20003BCO:
0x20003BD0:

CAFEF00D CAFEF00D CAFEF00D CAFEF00D
CAFEF00D CAFEF00D CAFEF00D CAFEF00D

: CAFEFOOD CAFEF00D CAFEFO0D CAFEF00D
0x20003BF0:
0x20003C00:
0x20003C10:
0x20003C20:
0x20003C30:
0x20003C40:
0x20003C50:
0x20003C60:

CAFEF00D CAFEF00D 00000000 CAFEFO0D
00000004 20001D04 CAFEF00D FFFFEF68
CAFEFO00D 00001098 CAFEFO0D CAFEF00D
CAFEF00D CAFEF00D 00001006 200018D8
00000001 200018D8 20001C50 00000004
20001BB0 000134A5 0000100D 20001D28
00000006 00000006 20001C38 20001D44
20001C6C 20001D44 00000006 00000005
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0x20003C70:
0x20003C80:
0x20003C90:
0x20003CAO0:
0x20003CBO:
0x20003CCO0:
0x20003CDO:
0x20003CEQ:
0x20003CFO0:
0x20003D00:
0x20003D10:
0x20003D20:
0x20003D30:
0x20003D40:
0x20003D50:
0x20003D60:
0x20003D70:
0x20003D80:
0x20003D90:
0x20003DA0:
0x20003DB0:
0x20003DCO0:
0x20003DDO:
0x20003DEO:
0x20003DFO0:

0x20003E00:
0x20003E10:
0x20003E20:
0x20003E30:
0x20003E40:
0x20003E50:
0x20003E60:
0x20003E70:
0x20003E80:
0x20003E90:

0x20003EAO0:
0x20003EBO:
0x20003ECO:
0x20003EDO:
0x20003EEQ:
0x20003EFO0:

0x20003F00:
0x20003F10:
0x20003F20:
0x20003F30:
0x20003F40:
0x20003F50:
0x20003F60:
0x20003F70:
0x20003F80:
0x20003F90:

0x20003FA0:
0x20003FB0:
0x20003FCO0:
0x20003FDO:
0x20003FEO:

0x20003FFO0:
OK
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20001D38 00000005 20001D38 00000000
00000001 00012083 200018C8 000013D3
00550000 00000001 80E80000 4FC40000
000080E8 00000009 60900000 000080E8
60140000 20002764 0009608F 000080E8
80000000 000080E8 00000000 00129F5F
00000000 0001E4D9 80E80000 200018C8
200018D4 00000000 80E80000 000000FF
0000011C 0001BCE1 0000203A 0001BC1D
00000000 0001BC1D 80E80000 0001BCE1
0000011C 0001BDA9 80E80000 0001BDA9
0000011C FFFFFFF9 008B8000 0001BC1D
00000048 00000010 0000A000 00000009
0001E326 00000001 80E80000 51538000
000080E8 0001E9CF 00000000 00000009
61C78000 000080E8 00000048 00000504
0000A1FC 0002125C 00000000 000080E8
00000000 0012A236 00000000 0001E4D9
000080E8 00000009 00004998 000080E8
622C8000 0012A29B 00000042 0001E479
40011000 000185EF 00006E10 00000000
00000000 00000004 0000000C 00000000
62780000 00018579 2000311B 0001ACDF
00000000 20003054 20002050 00000001
20003DF8 0002085D 00000001 200030D4
00000200 0001F663 00000001 200030D4
00000001 2000311B 0001F631 00020A6D
00000001 00000000 0000000C 200030D4
2000311B 00000042 200030D4 00020AD7
20002050 200030D4 20002050 00020833
20002050 20003F 1B 20002050 0001FF89
20002050 0001FFA3 00000005 20003ED8
20002050 0001FF8B 00000010 00020491
00000001 0012A54E 00000020 00022409
00000000 20002050 200030D4 0001FF8B
00021263 00000005 0000000C 20003F74
20003ED8 20002050 200030D4 00020187
20003ED4 20003054 00000000 20003F75
00000008 20003F64 00000084 FFFFFFFF
FFFFFFFF 00000008 00000001 00000008
20302058 2000311B 0001F631 00020A6D
20002050 00000000 0000000C 200030D4
32002050 32303032 00323330 000258D7
20002050 200030D4 20002050 00020833
00000000 20002050 00000020 000001CE
20003F40 200030D4 00000004 0001ED83
200030D4 20003F60 000001D6 000001D7
000001D8 00016559 0000000C 00000000
6C383025 00000058 200030D4 FFFFFFFF
1FFF4000 00000028 00000028 000217F8
200020C7 000166C5 000166AD 00017ED9
FFFFFFFF 200020B8 2000306C 200030D4
200020B4 000180AD 1FFF4000 200020B0
200020B0 200020B0 1FFF4000 0001A63D
CAFEF00D CAFEFO00D 200020B4 00000002
FFFFFFFF FFFFFFFF 1FFF4000 00000000
00000000 00000000 00000000 00016113
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History

This page tracks additions or changes to the AT command set based on the firmware version number (which you can obtain via the 'ATI'
command):

Version 0.7.0

The following AT commands were added in the 0.7.0 release:

L]

AT+BAUDRATE
Change the HW UART baudrate
AT+UARTFLOW
Enable or disable HW UART flow control
AT+BLEMIDIEN=0n/off/0/1
Enable/disable MIDI service, requires a reset to take affect
AT+BLEMIDITX
Send a MIDI event
AT+BLEMIDIRX
Receive an available MIDI event
AT+GATTCHARRAW
Added this read only command to read binary (instead of ASCII) data from a characteristic. It is non-printable but less overhead and easier
for writing library in Arduino
AT+NVMWRITE=offset,datatype,data
Writes data to 256 byte user NVM. Datatype must be STRING (1), BYTEARRAY (2), or INTEGER (3)
AT+NVMREAD=0ffset,size,datatype
Reads data back from 256 bytes user NVM
AT+NVMREADRAW-=0ffset,size binary data
Binary data (instead of ASCII) is returned, ending with "OK\r\n". It is non-printable but less overhead and easier to use in some situations.
AT+BLEHIDGAMEPAD=x,y,buttons
o Xis LEFT, RIGHT: X=-1 LEFT is pressed, X=1 RIGHT is pressed, X=0 no pressed
o Yis UP, DOWN: Y=-1iUP, Y=1is DOWN, Y=0 no pressed
o Button [0x00-0xFF] is a bit mask for 8 button 0-7
AT+GAPCONNECTABLE=0n/off/1/0
Allow/disallow connection to the device
AT+EDDYSTONESERVICEEN
Add/remove EddyStone service to GATT table (requires reset)
AT+EDDYSTONEBROADCAST=on/off/0/1
Start/stop broadcasting url using settings from NVM
AT+BLEBATTEN=0n/0ff/1/0
Enable battery service. Reset required due to the service change.
AT+BLEBATTVAL=percent
Updates the Battery level, percent is 0 to 100

The following commands were changed in the 0.7.0 release:

L]

L]

AT+GATTADDCHAR
o Added a DATATYPE option to indicate the data type for the GATT characteristic's payload. Valid option are: AUTO (0, default),
STRING (1), BYTEARRAY (2), INTEGER (3)
o Added characteristic user description option via the DESCRIPTION flag
o Added characteristic presentation format support via the PRESENTATION flag
AT+GAPINTERVALS
Added a new 'adv_lowpower_interval' parameter, default value is 417.5 ms. Current arguments are now: min_conn, max_conn, adv_interval,
adv_timeout, adv_lowpower_interval

Key bug fixes and changes in this release:

L]

L]

L]

L]

© Adafruit Industries

Significant BTLE UART speed and reliability improvements
Added callback support (work in progress) for:

o BLE UART RX

o GATT Characteristic(s) RX

o MIDI RX

o Connect/Disconnect
Increased MAX_LEN for each characteristic from 20 to 32 bytes
Changed the default GAP parameters:
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o Advertising interval = 20ms
o Min connection interval = 20 ms
o Max connection interval = 40 ms
Increased the maximum number of CCCDs saved to flash from 8 to 16
Eddystone config service disabled by default
Removed AT+EDDYSTONEENABLE to avoid confusion
Changed advertising timeout for Eddystone to 'unlimited'
Fixed Write-No-Response characteristic property, which wasn't being handled properly
Fixed timing constraints to meet Apple design guidelines
Fixed systick to ms calculation
Fixed all tests with google eddystone validator except for writing tx_power = 1 dB (not valid on nrf51)
Fixed a bug where writing from the central does not update the value on the characteristic correctly
Fixed an issue with HID examples, where when paired with Central, a disconnect then reconnect could not send HID reports anymore

Version 0.6.7

The following AT commands were added in the 0.6.7 release:

e o o o o o o o o o

e AT+BLEUARTFIFO
Returns the number of free bytes available in the TX and RX FIFOs for the Bluetooth UART Service.

The following commands were changed in the 0.6.7 release:

o AT+BLEUARTTX
If the TX FIFQ is full, the command will wait up to 200ms to see if the FIFO size decreases before exiting and returning an ERROR response
due to the FIFO being full.

e AT+BLEURIBEACON
This command will go back to using the old (deprecated) UriBeacon UUID (0xFEDS8), and only the AT+EDDYSTONEURL command will use
the newer Eddystone UUID (OxFEAA).

o AT+BLEKEYBOARD and AT+BLEUARTTX
These commands now accept '\?' as an escape code since 'AT+BLEKEYBOARD="?' has another meaning for the AT parser. To send a
single question mark the following command should be used: 'AT+BLEKEYBOARD=\?' or 'AT+BLEUARTTX=\?'

o AT+EDDYSTONEURL
This command now accepts an optional third parameter for RSSI at 0m value (default is -18dBm).
Running this command with no parameters ((AT+EDDYSTONEURL\AN') will now return the current URL.

Key bug fixes in this release:

e The FIFO handling for the Bluetooth UART Service was improved for speed and stability, and the TX and RF FIFOs were increased to 1024
bytes each.

e Anissue where a timer overflow was causing factory resets every 4 hours or so has been resolved.

o Fixed a problem with the GATT server where 'value_len' was being incorrectly parsed for integer values in characteristics where 'max_len' >4

Version 0.6.6

The following AT commands were added in the 0.6.6 release:

o AT+EDDYSTONEURL
Update the URL for the beacon and switch to beacon mode
o AT+EDDYSTONEENABLE
Enable/disable beacon mode using the configured url
o AT+EDDYSTONECONFIGEN
Enable advertising for the the Eddystone configuration service for the specified number of seconds
o AT+HWMODELED
Allows the user to override the default MODE LED behaviour with one of the following options: DISABLE, MODE, HWUART, BLEUART, SPI,
MANUAL
o AT+BLECONTROLKEY
Allows HID media control values to be sent to a bonded central device (volume, screen brightness, etc.)
e AT+BLEHIDEN
Enables or disables BLE HID support in the Bluefruit LE firmware (mouse, keyboard and media control)
¢ AT+BLEMOUSEMOVE
To move the HID mouse
o AT+BLEMOUSEBUTTON
To set the state of the HID mouse buttons

The following commands were changed in the 0.6.6 release:
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e AT+BLEKEYBOARDEN - Now an alias for AT+BLEHIDEN
e AT+GATTADDCHAR - Added a new UUID128 field to allow custom UUIDs

Key bug fixes in this release:

e Fixed issues with long beacon URLs
* Fixed big endian issue in at+blebeacon for major & minor number

Known issues with this release:

e Windows 10 seems to support a limited number of characteristics for the DIS service. We had to disable the Serial Number characteristic to
enable HID support with windows 10.

Version 0.6.5

The following AT commands were added in the 0.6.5 release:
o AT+BLEGETPEERADDR (http://adafru.it/iCq)
The following commands were changed in the 0.6.5 release:

Increased the UART buffer size (on the nRF51) from 128 to 256 bytes

+++ now responds with the current operating mode

Fixed a bug with AT+GATTCHAR values sometimes not being saved to NVM

Fixed a bug with AT+GATTCHAR max_len value not being taken into account after a reset (min_len was always used when repopulating the
value)

Version 0.6.2

This is the first release targetting32KB SRAM parts (QFAC). 16KB SRAM parts can't be used with this firmware due to memory management
issues, and should use the earlier 0.5.0 firmware.

e o o o

The following AT commands were changed in the 0.6.2 release:

e AT+BLEUARTTX (http:/adafru.it/iCr)
Basic escape codes were added for new lines, tabs and backspace
e AT+BLEKEYBOARD (http://adafru.it/iCr)
Also works with OS X now, and may function with other operating systems that support BLE HID keyboards

Version 0.5.0

The following AT commands were added in the 0.5.0 release:

o AT+BLEKEYBOARDEN (http:/adafru.it/iCr)
o AT+BLEKEYBOARD (http:/adafru.it/iCr)
o AT+BLEKEYBOARDCODE (htip:/adafru.it/iCr)

The following AT commands were changed in the 0.5.0 release:

o ATI (http://adafru.it/iCs)
The SoftDevice, SoftDevice version and bootloader version were added as a new (7th) record. For Ex: "S110 7.1.0, 0.0" indicates version
7.1.0 of the S110 softdevice is used with the 0.0 bootloader (future boards will use a newer 0.1 bootloader).

Other notes concerning 0.5.0:

Starting with version 0.5.0, you can execute the AT+FACTORYRESET command at any point (and without a terminal emulator) by holding the
DFU button down for 10 seconds until the blue CONNECTED LED starts flashing, then releasing it.

Version 0.4.7

The following AT commands were added in the 0.4.7 release:

e +++ (http://adafru.it/iCs)
o AT+HWRANDOM (http://adafru.it/iCt)
e AT+BLEURIBEACON (http://adafru.it/iCu)
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file:///introducing-adafruit-ble-bluetooth-low-energy-friend/ble-generic#at-plus-blegetpeeraddr
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/ble-services#at-plus-bleuartrx
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/ble-services#at-plus-blekeyboard
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/ble-services#at-plus-blekeyboarden
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/ble-services#at-plus-blekeyboard
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/ble-services#at-plus-blekeyboardcode
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/standard-at#ati
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/standard-at#plus-plus-plus
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/hardware#at-plus-hwrandom
file:///introducing-adafruit-ble-bluetooth-low-energy-friend/beacon#at-plus-bleuribeacon

o AT+DBGSTACKSIZE (http:/adafru.it/iCv)
o AT+DBGSTACKDUMP (http://adafru.it/iCv)

The following commands were changed in the 0.4.7 release:

o ATI
(http://adafru.it/iCs)The chip revision was added after the chip name. Whereas ATI would previously report 'nRF51822', it will now add the
specific HW revision if it can be detected (ex 'nRF51822 QFAAGO00')

Version 0.3.0

o First public release
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SDEP (SPI Data Transport)

In order to facilitate switching between UART and SPI based Bluefruit LE modules, the Bluefruit LE SPI Friend and Shield uses the same AT
command set at the UART modules (ATI, AT+HELP, etc.).

These text-based AT commands are encoded as binary messages using a simple binary protocol we've namedSDEP (Simple Data Exhange
Protocol).

Most of the time, you never need to deal with SDEP directly, but we've documented the protocol here in case you need understand the Bluefruit LE
SPl interface in depth!

SDEP Overview

SDEP was designed as a bus neutral protocol to handle binary commands and responses -- including error responses -- in a standard, easy to
extend manner. 'Bus neutral' means that we can use SDEP regardless of the transport mechanism (USB HID, SPI, 12C, Wireless data over the air,
etc.).

All SDEP messages have a four byte header, and in the case of the Bluefruit LE modulesup to a 16 byte payloads. Larger messages are
broken up into several 4+16 bytes message chunks which are rebuilt at either end of the transport bus. The 20 byte limit (4 byte header + 16 byte
payload) was chosen to take into account the maximum packet size in Bluetooth Low Energy 4.0 (20 bytes per packet).

SPI Setup

While SDEP is bus neutral, in the case of the Bluefruit LE SPI Friend or Shield, an SPI transport is used with the following constraints and
assumptions, largely to take into account the HW limitations of the nRF51822 system on chip:

SPI Hardware Requirements

The SPI clock should run <=4MHz

A 100us delay should be added between the moment that the CS line is asserted, and before any data is transmitted on the SPI bus
The CS line must remain asserted for the entire packet, rather than toggling CS every byte

The CS line can however be deasserted and then reasserted between individual SDEP packets (of up to 20 bytes each).

The SPI commands must be setup to transmit MSB (most significant bit (http:/adafru.it/pBP)) first (not LSB first)

IRQ Pin

e o o o o

The IRQ line is asserted by the Bluefruit LE SPI Friend/Shield as long as an entire SDEP packet is available in the buffer on the nRF51822, at
which point you should read the packet, keeping the CS line asserted for the entire transaction (as detailed above).

The IRQ line will remain asserted as long as one or more packets are available, so the line may stay high after reading a packet, meaning that
more packets are still available in the FIFO on the SPI slave side.

SDEP Packet and SPI Error Identifier

Once CS has been asserted and the mandatory 100us delay has passed, a single byte should be read from the SPI bus which will indicate the
type of payload available on the nRF51822 (see Message Type Indicator below for more information on SDEP message types). Keep CS asserted
after this byte has been read in case you need to continue reading the rest of the frame.

If a standard SDEP message type indicator (0x10, 0x20, 0x40 or 0x80) is encountered, keep reading as normal. There are two other indicators
that should be taken into account, though, which indicate a problem on the nRF51822 SPI slave side:

e OxFE: Slave device not ready (wait a bit and try again)
e OxFF: Slave device read overflow indicator (you've read more data than is available)

This means there are six possible response bytes reading the message type indicator (the first byte read after an SDEP command is sent): 0x10,
0x20, 0x40, 0x80, which indicate a valid message type, or OXFE, OxFF which indicate an error condition.

Sample Transaction

The following image shows a sample SDEP response that is spread over two packets (since the response is > 20 bytes in size). Notice that the
IRQ line stays asserted between the packets since more than one packet was available in the FIFO on the Bluefruit LE SPI side:
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SDEP (Simple Data Exchange Protocol)

The Simple Data Exchange Protocol (SDEP) can be used to send and receive binary messages between two connected devices using any binary
serial bus (USB HID, USB Bulk, SPI, 12C, Wireless, etc.), exchanging data using one of four distinct message types (Command, Response, Alert
and Error messages).

The protocol is designed to be flexible and extensible, with the only requirement being thatindividual messages are 20 bytes or smaller,and

that the first byte of every message is a one byte (U8) identifier that indicates the message type, which defines the format for the remainder of the
payload.

Endianness
All values larger than 8-bits are encoded in little endian format. Any deviation from this rule should be clearly documented.
Message Type Indicator

The first byte of every message is an 8-bit identifier called theMessage Type Indicator. This value indicates the type of message being sent, and
allows us to determine the format for the remainder of the message.

Message ID
Type (U8)
Command 0x10

Response 0x20
Alert 0x40

Error 0x80

SDEP Data Transactions

Either connected device can initiate SDEP transactions, though certain transport protocols imposes restrictions on who can initiate a transfer. The
master device, for example, always initiates transactions with Bluetooth Low Energy or USB, meaning that slave devices can only reply to
incoming commands.

Every device that receives a Command Message must reply with a Response Message, Error Message or Alert message.
Message Types

Command Messages

Command messages (Message Type = 0x10) have the following structure:

Name Type Meaning
Message Type U8  Always '0x10'

Command ID U16  ynique Command Identifier

Payload Length U8 7] More data

[6-5] Reserved
[4-0] Payload length (0..16)

Optional command payload (parameters,
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Payload .. etc)

Command ID (bytes 1-2) and Payload Length (byte 3) are mandatory in any command message. The message payload is optional, and will be
ignored if Payload Length is set to 0 bytes. When a message payload is present, it's length can be anywhere from 1..16 bytes, to stay within the
20-byte maximum message length.

A long command (>16 bytes payload) must be divided into multiple packets. To facilitate this, theMore data field (bit 7 of byte 3) is used to
indicate whether additional packets are available for the same command. The SDEP receiver must continue to reads packets until it finds a packet
with More data == 0, then assemble all sub-packets into one command if necessary.

The contents of the payload are user defined, and can change from one command to another.

A sample command message would be:

10341201 FF

0: Message Type (U8)

0x10
1+2: Command ID
40x12
(U16) 0x34 0x
1
3: Payload Len (Ug)  OX°
OXFF

4: Payload (...)

L]

The first byte is the Message Type (0x10), which identifies this as a command message.

The second and third bytes are 0x1234 (34 12 in little-endian notation), which is the unique command ID. This value will be compared
against the command lookup table and redirected to an appropriate command handler function if a matching entry was found.

The fourth byte indicates that we have a message payload of 1 byte

The fifth byte is the 1 byte payload: OxFF

L]

L]

L]

Response Messages

Response messages (Message Type = 0x20) are generated in response to an incoming command, and have the following structure:

Name Type Meaning

Message Type U8 Always '0x20'

Command ID U16 Command ID this message is a response to

Payload Length U8 [7] More data

[6-5] Reserved
[4-0] Payload length (0..16)

Optional response payload (parameters,
Payload etc.)

By including the Command ID that this response message is related to, the recipient can more easily correlate responses and commands. This is
useful in situations where multiple commands are sent, and some commands may take a longer period of time to execute than subsequent
commands with a different command ID.

Response messages can only be generate in response to a command message, so the Command ID field should always be present.

A long response (>16 bytes payload) must be divided into multiple packets. Similar to long commands, theMore data field (bit 7 of byte 3) is used
to indicate whether additional packets are available for the same response. On responses that span more than one packet, the More data bit on
the final packet will be set to 0 to indicate that this is the last packet in the sequence. The SDEP receiver must re-assemble all sub-packets in into
one payload when necessary.

If more precise command/response correlation is required a custom protocol should be developed, where a uniqgue message identifier is included
in the payload of each command/response, but this is beyond the scope of this high-level protocol definition.

A sample response message would be:

20341201 FF

0: Message Type (U8) 0x20
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1+2: Command ID 0x34 0x12

(U16)
0x01

3: Payload Len (U8)
OxFF

4: Payload

The first byte is the Message Type (0x20), which identifies this as a response message.

The second and third bytes are 0x1234, which is the unique command ID that this response is related to.
The fourth byte indicates that we have a message payload of 1 byte.

The fifth byte is the 1 byte payload: OxFF

e o o o

Alert Messages

Alert messages (Message Type = 0x40) are sent whenever an alert condition is present on the system (low battery, etc.), and have the following
structure:

Name Type Meaning

Message Type U8 Always '0x40

Unique ID for the Alert

Alert ID 1
ert u1e Condition

Payload Length
ayload Length U8 Payload Length (0..16)

Payload Optional response payload

A sample alert message would be:

40 CD AB 04 42 07 00 10

0: Message Type

4

(Us) 0x40

142: Alert ID (U1)  OXCD OXAB
0x04

3: Payload Length

42 0x07 1
4+54647: Payload ~ CX42 0x070x000x10

The first byte is the Message Type (0x40), which identifies this as an alert message.

The second and third bytes are 0OxABCD, which is the unique alert ID.

The fourth byte indicates that we have a message payload of 4 bytes.

The last four bytes are the actual payload: 0x10000742 in this case, assuming we were transmitting a 32-bit value in little-endian format.

Standard Alert IDs

Alert IDs in the range of 0x0000 to 0xO0FF are reserved for standard SDEP alerts, and may not be used by custom alerts.

The following alerts have been defined as a standard part of the protocol:

ID Alert Description

0x0000 Reserved Reserved for future use
0x0001 System Reset The system is about to reset
0x0002 Battery Low  The battery level is low

0x0003 Battery Critical The battery level is critically low

Error Messages

Error messages (Message Type = 0x80) are returned whenever an error condition is present on the system, and have the following structure:
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Name Type Meaning
Message Type U8  Always '0x80'
Error ID U16 Unique ID for the error

condition
Reserved us

Reserved for future use

Whenever an error condition is present and the system needs to be alerted (such as a failed request, an attempt to access a non-existing resource,
etc.) the system can return a specific error message with an appropriate Error ID.

A sample error message would be:

80 01 0000

0: Message ID

(U8) 0x80

1+2: Error ID (U16) 01 0X00
0x00

3: Reserved (U8)

Standard Error IDs

Error IDs in the range of 0x0000 to 0xO0FF are reserved for standard SDEP errors, and may not be used by custom errors.

The following errors have been defined as a standard part of the protocol:

D Error Description

0x0000 Reserved Reserved for future use

CMD ID wasn't found in the lookup

0x0001 Invalid CMD ID
table

Invalid Payl
0x0003 Invalid Payload The message payload was invalid

Existing Commands

At present, there are only four SDEP commands implemented in the Bluefruit SPIFRIEND32 firmware:

SDEP_CMDTYPE_INITIALIZE = OxBEEF
SDEP_CMDTYPE_AT_WRAPPER = 0x0A00
SDEP_CMDTYPE_BLE_UARTTX = 0x0A01
SDEP_CMDTYPE_BLE_UARTRX = 0x0A02

L]
L]
L]
L]

SDEP_CMDTYPE_INITIALIZE can be used to reset the SDEP system when a HW RST line isn't available.
The two SDEP_CMDTYPE_UART* commands send data over the BLE UART service.

SDEP_CMDTYPE_AT_WRAPPER is the command you will use most of the time, which is a wrapper that sends AT commands over the binary
SDEP transport. This isn't terribly efficient, and a binary mechanism would have taken less bytes per command, but it allows the reuse of all of the
earlier AT parser commands without having to implement one wrapper for every command which would significantly increase the overall code size.

SDEP AT Wrapper Usage

To use the SDEP AT Wrapp you simply send the correct header, along with the AT command you which to send to the parser. For example:
10-00-0A-03-a"-t-T’

Message Type: 0x10 (Command)
Command ID: 0x0A00
Command Payload Length: 3 bytes

L]
L]
L]
e Command Payload: 'a" +'t' + 'i'
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This will cause the ATI command to be executed, which will return basic system information.
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GATT Service Details

Data in Bluetooth Low Energy is organized around units called GATT Services (http://adafru.it/iCp)' and 'GATT Characteristics'. To expose data to
another device, you must instantiate at least one service on your device.

Adafruit's Bluefruit LE Pro modules support some 'standard' services, described below (more may be added in the future).

UART Service

The UART Service is the standard means of sending and receiving data between connected devices, and simulates a familiar two-line UART
interface (one line to transmit data, another to receive it).

The service is described in detail on the dedicatedUART Service (http://adafru.it/iCn) page.
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UART Service

Base UUID: 6E400001-B5A3-F393-E0A9-E50E24DCCA9E
This service simulates a basic UART connection over two lines, TXD and RXD.

It is based on a proprietary UART service specification by Nordic Semiconductors. Data sent to and from this service can be viewed using the
nRFUART apps from Nordic Semiconductors for Android and iOS.

This service is available on every Bluefruit LE module and is automatically started during the power-up sequence.

Characteristics

Nordic’s UART Service includes the following characteristics:

Name Mandatory UUID Type RWNI
TX  Yes 0x0002 U8[20] X

RX Yes 0x0003 U8[20] X X

R = Read; W = Write; N = Notify; | = Indicate

Characteristic names are assigned from the point of view of the Central device

TX (0x0002)

This characteristic is used to send data back to the sensor node, and can be written to by the connected Central device (the mobile phone, tablet,
etc.).

RX (0x0003)

This characteristic is used to send data out to the connected Central device. Notify can be enabled by the connected device so that an alert is
raised every time the TX channel is updated.
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Software Resources

To help you get your Bluefruit LE module talking to other Central devices, we've put together a number of open source tools for most of the major
platforms supporting Bluetooth Low Energy.

Bluefruit LE Client Apps and Libraries

Adafruit has put together the following mobile or desktop apps and libraries to make it as easy as possible to get your Bluefruit LE module talking
to your mobile device or laptop, with full source available where possible:

Bluefruit LE Connect (http://adafru.it/f4G) (Android/Java)

Bluetooth Low Energy support was added to Android starting with Android 4.3 (though it was only really stable starting with 4.4), and we've
already released Bluefruit LE Connect to the Play Store (http://adafru.it/f4G).

The full source code (http://adafru.it/fY9) for Bluefruit LE Connect for Android is also available on Github to help you get started with your own
Android apps. You'll need a recent version of Android Studio (http://adafru.it/fYa) to use this project.

Adafruit Bluefruit LE Connect
S""“/__{\ Adafruit Industries Education Ahdhkh 4T 2

£l PEGI3

= =

Bluefruit LE Connect (http://adafru.it/f4H) (iI0S/Swift)

Apple was very early to adopt Bluetooth Low Energy, and we also have an iOS version of theBluefruit LE Connect (http://adafru.it/f4H) app
available in Apple's app store.

The full swift source code for Bluefruit LE Connect for iOS is also available on Github. You'll need XCode and access to Apple's developper
program to use this project:

e Version 1.x source code: https:/github.com/adafruit/Bluefruit LE_Connect (http://adafru.it/ddv)
e Version 2.x source code: https:/github.com/adafruit/Bluefruit LE_Connect v2 (http://adafru.it/09E)

Version 2.x of the app is a complete rewrite that includes iOS, OS X GUI and OS X command-line tools in a single codebase.
Adafruit Bluefruit LE Connect bbb

Description

adafruit Industries Web Site » Adafruit Bluefruit LE Connect Support +

What's New in Version 1.7

Bluefruit LE Connect for X (http://adafru.it/o9F) (Swift)

This OS X desktop application is based on the same V2.x codebase as the iOS app, and gives you access to BLE UART, basic Pin I/O and OTA
DFU firmware updates from the convenience of your laptop or mac.

This is a great choice for logging sensor data locally and exporting it as a CSV, JSON or XML file for parsing in another application, and uses the
native hardware on your computer so no BLE dongle is required on any recent mac.

The full source is also available on Github (http://adafru.it/o9E).

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industri . .
dafruit Industries microcontroller-usb-bluetooth-le-in-one

Page 104 of 113


https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://play.google.com/store/apps/details?id=com.adafruit.bluefruit.le.connect
https://github.com/adafruit/Bluefruit_LE_Connect_Android
https://developer.android.com/sdk/index.html
https://itunes.apple.com/app/adafruit-bluefruit-le-connect/id830125974?mt=8
https://itunes.apple.com/app/adafruit-bluefruit-le-connect/id830125974?mt=8
https://github.com/adafruit/Bluefruit_LE_Connect
https://github.com/adafruit/Bluefruit_LE_Connect_v2
https://itunes.apple.com/us/app/adafruit-bluefruit-le-connect/id1082414600?mt=12
https://github.com/adafruit/Bluefruit_LE_Connect_v2

Bluefruit LE Command Lin r for X (http://adafru.it/pLF)
(Swift)

This experimental command line tool is unsupported and provided purely as a proof of concept, but can be used to allow firmware updates for
Bluefruit devices from the command line.

This utility performs automatic firmware updates similar to the way that the GUI application does, by checking the firmware version on your
Bluefruit device (via the Device Information Service), and comparing this against the firmware versions available online, downloading files in the
background if appropriate.

Simply install the pre-compiled tool via theDMG file (http://adafru.it/pLF) and place it somewhere in the system path, or run the file locally via
"./bluefruit' to see the help menu:

$ /bluefruit

bluefruit v0.3

Usage:

bluefruit <command> [options...]

Commands:

Scan peripherals: scan

Automatic update: update [--enable-beta] [--uuid <uuid>]

Custom firmware: dfu --hex <filename> [--init <filename>] [--uuid <uuid>]
Show this screen: --help

Show version: --version

Options:
--uuid <uuid>  If present the peripheral with that uuid is used. If not present a list of peripherals is displayed
--enable-beta If not present only stable versions are used

Short syntax:
-U = --uuid, -b = --enable-beta, -h = --hex, -i = --init, -v = --version, -? = --help

Deprecated: Bluefruit Buddy (http://adafru.it/mCn) (OS X)

This native OS X application is a basic proof of concept app that allows you to connect to your Bluefruit LE module using most recent macbooks or
iMacs. You can get basic information about the modules and use the UART service to send and receive data.

The full source for the application is available in the github repo atAdafruit_BluefruitLE_OSX (http://adafru.it/mCo).
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ABLE (http://adafru.it/ijB) (Cross Platform/Node+Electron)

ABLE (http://adafru.it/ijB) (Adafruit Bluefruit LE Desktop) is a cross-platform desktop application based on Sandeep Misty'snoble
library (http://adafru.it/ijC) and the Electron (http://adafru.it/ijD) project from Github (used by Atom).

It runs on OS X, Windows 7+ and select flavours of Linux (Ubuntu tested locally). Windows 7 support is particularly interesting since Windows 7
has no native support for Bluetooth Low Energy but the noble library talks directly to supported Bluetooth 4.0 USB dongles (http://adafru.it/1327) to
emulate BLE on the system (though at this stage it's still in early BETA and drops the connection and takes more care to work with).

This app allows you to collect sensor data or perform many of the same functionality offered by the mobile Bluefruit LE Connect apps, but on the
desktop.

The app is still in BETA, but fullsource (http://adafru.it/ijE) is available in addition to the easy to usepre-compiled binaries (http://adafru.it/ijB).

¥ Bluefruit LE

Adafruit
Bluefruit LE

Bluefruit LE Python Wrapper (http:/adafru.it/fQF)

As a proof of concept, we've played around a bit with getting Python working with the native Bluetooth APIs on OS X and the latest version of
Bluez on certain Linux targets.

There are currently example sketches showing how to retreive BLE UART data as well as some basic details from the Device Information Service
(DIS).
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This isn't an actively support project and was more of an experiment, but if you have a recent Macbook or a Raspberry Pi and know Python, you
might want to look at Adafruit Python_BluefruitLE (http://adafru.it/fQF) in our github account.

Debug Tools

If your sense of adventure gets the better of you, and your Bluefruit LE module goes off into the weeds, the following tools might be useful to get it
back from unknown lands.

These debug tools are provided purely as a convenience for advanced users for device recovery purposes, and are not recommended unless
you're OK with potentially bricking your board. Use them at your own risk.

AdalLink (http://adafru.it/fPq) (Python)

This command line tool is a python-based wrapper for programming ARM MCUs using either aSegger J-Link (http:/adafru.it/fYU) or an
STLink/V2 (http://adafru.it/ijF). You can use it to reflash your Bluefruit LE module using the latest firmware from theBluefruit LE firmware
repo (http://adafru.it/edX).

Details on how to use the tool are available in the readme.md file on the mainAdafruit_Adalink (http://adafru.it/fPq) repo on Github.
Completely reprogramming a Bluefruit LE module with AdaLink would require four files, and would look something like this (using a JLink):

adalink nrf51822 --programmer jlink --wipe
--program-hex "Adafruit_BluefruitLE_Firmware/softdevice/s110_nrf51_8.0.0_softdevice.hex"
--program-hex "Adafruit_BluefruitLE_Firmware/bootloader/bootloader_0002.hex"
--program-hex "Adafruit_BluefruitLE_Firmware/0.6.7/blefriend32/blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex"
--program-hex "Adafruit_BluefruitLE_Firmware/0.6.7/blefriend32/blefriend32_s110_xxac_0_6_7_150917_blefriend32_signature.hex"

You can also use the AdaLink tool to get some basic information about your module, such as which SoftDevice is currently programmed or the IC
revision (16KB SRAM or 32KB SRAM) via the --info command:

$ adalink nrf51822 -p jlink --info
Hardware ID : QFACA10 (32KB)
Segger ID : nRF51822_xxAC
SD Version :51108.0.0

Device ID : ***rerrnininirk

Adafruit nRF51822 Flasher (http://adafru.it/fVL) (Python)

Adafruit's nRF51822 Flasher is an internal Python tool we use in production to flash boards as they go through the test procedures and off the
assembly line, or just testing against different firmware releases when debugging.

It relies on AdaLink or OpenOCD beneath the surface (see above), but you can use this command line tool to flash your nRF51822 with a specific
SoftDevice, Bootloader and Bluefruit firmware combination.

It currently supports using either a Segger J-Link or STLink/V2 via AdaLink, oiGPIO on a Raspberry Pi (http://adafru.it/fVL) if you don't have
access to a traditional ARM SWD debugger. (A pre-built version of OpenOCD for the RPi is included in the repo since building it from scratch
takes a long time on the original RPi.)

We don't provide active support for this tool since it's purely an internal project, but made it public just in case it might help an adventurous
customer debrick a board on their own.

$ python flash.py --jtag=jlink --board=blefriend32 --softdevice=8.0.0 --bootloader=2 --firmware=0.6.7

jtag :jlink

softdevice :8.0.0

bootloader : 2

board : blefriend32

firmware :0.6.7

Writing Softdevice + DFU bootloader + Application to flash memory

adalink -v nrf51822 --programmer jlink --wipe --program-hex "Adafruit_BluefruitLE_Firmware/softdevice/s110_nrf51_8.0.0_softdevice.hex" --program-hex "Adafruit_BluefruitLE_Firmv
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BLE FAQ

Can | talk to Classic Bluetooth devices with a Bluefruit LE modules?

No. Bluetooth Low Energy and 'Classic' Bluetooth are both part of the same Bluetooth Core Specification -- defined and maintained by the
Bluetooth SIG -- but they are completely different protocols operating with different physical constraints and requirements. The two protocols can't
talk to each other directly.

Can my Bluefruit LE module connect to other Bluefruit LE peripherals

No, the Bluefruit LE firmware from Adafruit is currently peripheral only, and doesn't run in Central mode, which would cause the module to behave
similar to your mobile phone or BLE enabled laptop.

At some point we might consider a new firmware image offering this, but since 98% of the uses cases for BLE involved running as a peripheral
we've concentrated all of our development effort there for now.

Why are none of my changes persisting when | reset with the sample sketches?

In order to ensure that the Bluefruit LE modules are in a known state for the Adafruit demo sketches, most of them perform a factory reset at the
start of the sketch.

This is useful to ensure that the sketch functions properly, but has the side effect of erasing any custom user data in NVM and setting everything
back to factory defaults every time your board comes out of reset and the sketch runs.

To disable factory reset, open the demo sketch and find the FACTORYRESET_ENABLE flag and set this to '0', which will prevent the factory reset
from happening at startup.

If you don't see the 'FACTORYRESET_ENABLE' flag in your .ino sketch file, you probably have an older version of the sketches and may need to
update to the latest version via the Arduino library manager.

Do | need CTS and RTS on my UART based Bluefruit LE Module?

Using CTS and RTS isn't strictly necessary when using HW serial, but they should both be used with SW serial, or any time that a lot of data is
being transmitted.

The reason behind the need for CTS and RTS is that the UART block on the nRF51822 isn't very robust, and early versions of the chip had an
extremely small FIFO meaning that the UART peripheral was quickly overwhelmed.

Using CTS and RTS significantly improves the reliability of the UART connection since these two pins tell the device on the other end when they
need to wait while the existing buffered data is processed.

To enable CTS and RTS support, go into the BluefruitConfig.h file in your sketch folder and simply assign an appropriate pin to the macros
dedicated to those functions (they may be set to -1 if they aren't currently being used).

Enabling both of these pins should solve any data reliability issues you are having with large commands, or when transmitting a number of
commands in a row.

How can | update to the latest Bluefruit LE Firmware?

The easiest way to keep your Bluefruit LE modules up to date is with ourBluefruit LE Connect app for Android (http://adafru.it/f4G) or Bluefruit LE
Connect for iOS (http://adafru.it/f4H). Both of these apps include a firmware update feature that allows you to automatically download the latest
firmware and flash your Bluefruit LE device in as safe and painless a manner as possible. You can also roll back to older versions of the Bluefruit
LE firmware using these apps if you need to do some testing on a previous version.

Which firmware version supports 'xxx'?

We regularly release Bluefruit LE firmware images (http://adafru.it/edX) with bug fixes and new features. Each AT command in this learning guide
lists the minimum firmware version required to use that command, but for a higher level overview of the changes from one firmware version to the
next, consult the firmware history page (http://adafru.it/iCw).

Does my Bluefruit LE device support ANCS?

ANCS is on the roadmap for us (most likely in the 0.7.x release family), but we don't currently support it since there are some unusual edge cases
when implementing it as a service.

My Bluefruit LE device is stuck in DFU mode ... what can | do?
If your device is stuck in DFU mode for some reason and the firmware was corrupted, you have several options.

First, try a factory reset by holding down the DFU button for about 10 seconds until the CONN LED starts flashing, then release the DFU button to
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perform a factory reset.

If this doesn't work, you may need to reflash your firmware starting from DFU mode, which can be done in one of the following ways:
Bluefruit LE Connect (Android)

Place the module in DFU mode (constant LED blinky)
Open Bluefruit LE Connect
Connect to the 'DfuTarg' device
Once connected, you will see a screen with some basic device information. Click the '..." in the top-right corner and seledFirmware Updates
Click the Use Custom Firmware button
Select the appropriate .hex and .init files (copied from theBluefruit LE Firmware repo (http://adafru.it/edX)) ... for the BLEFRIEND32 firmware
version 0.6.7, this would be:
o Hex File: blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex
o Init File: blefriend32_s110_xxac_0_6_7_150917_blefriend32_init.dat
e Click Start Update

e o o o o o

Unfortunately, the iOS app doesn't yet support custom firmware updates from DFU mode yet, but we will get this into the next release.
Nordic nRF Toolbox

You can also use Nordic's nRF Toolbox application to update the firmware using the OTA bootloader.

On Android:
e Open nRF Toolbox (using the latest version)
e Click the DFU icon
o Click the Select File button
e Select Application from the radio button list, then click OK
e Find the appropriate .hex file (ex. 'blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex")
o When asked about the Init packet', indicate Yes, and select the appropriate *_init.dat file (for example:

'blefriend32_s110_xxac_0_6_7_150917_blefriend32_init.dat").

Click the Select Device button at the bottom of the main screen and find theDfuTarg device, clicking on it

e Click the Upload button, which should now be enabled on the home screen

« This will begin the DFU update process which should cause the firmware to be updated or restored on your Bluefruit LE module

L]

Onios:

o Create a .zip file containing the .hex file and init.dat file that you will use for the firmware update. For example:
o Rename 'blefriend32_s110_xxac_0_6_7_150917_blefriend32.hex' to application.hex
o Rename 'blefriend32_s110_xxac_0_6_7_150917_blefriend32_init.dat' to application.dat

e Upload the .zip file containing the application.hex and application.dat files to your iPhone using uTunes, as described

here (http://adafru.it/iCx)

Open the nRF Toolbox app (using the latest version)

Click the DFU icon

Click the Select File text label

Switch to User Files to see the .zip file you uploaded above

Select the .zip file (ex. blefriend32_065.zip)

On the main screen select Select File Type

Select application

On the main screen select SELECT DEVICE

Select DfuTarg

Click the Upload button which should now be enabled

This will begin the DFU process and your Bluefruit LE module will reset when the update is complete

If you get the normal 2 or 3 pulse blinky pattern, the update worked!

e o o o o o o o o o o o

Adafruit_nRF51822_Flasher

As a last resort, if you have access to a Raspberry Pi, a Segger J-Link or a STLink/V2, you can also try manually reflashing the entire device, as
described in the FAQ above (http://adafru.it/iCy), with further details on theSoftware Resources (http://adafru.it/iCz) page.

How do | reflash my Bluefruit LE module over SWD?

Reflashing Bluefruit LE modules over SWD (ex. switching to the sniffer firmware and back) isat your own risk and can lead to a bricked device,
and we can't offer any support for this operation! You're on your own here, and there are unfortunately 1,000,000 things that can go wrong,
which is why we offer two separate Bluefruit LE Friend boards -- the sniffer and the normal Bluefruit LE Friend board with the non-sniffer firmware,
which provides a bootloader with fail safe features that prevents you from ever bricking boards via OTA updates.

AdaLink (SWD/JTAG Debugger Wrapper)
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Transitioning between the two board types (sniffer and Bluefruit LE module) is unfortunately not a risk-free operation, and requires external
hardware, software and know-how to get right, which is why it isn't covered by our support team.

That said ... if you're determined to go down that lonely road, and you have aSegger J-Link (http://adafru.it/fYU) (which is what we use internally
for production and development), or have already erased your Bluefruit LE device, you should have a look at AdaLink (http://adafru.it/fPq), which is
the tool we use internally to flash the four files required to restore a Bluefruit LE module. (Note: recent version of AdaLink also support the cheaper
STLink/V2 (http://adafru.it/2548), though the J-Link is generally more robust if you are going to purchase a debugger for long term use.)

The mandatory Intel Hex files are available in theBluefruit LE Firmware repo (http://adafru.it/edX). You will need to flash:

An appropriate bootloader image

An appropriate SoftDevice image

The Bluefruit LE firmware image

The matching signature file containing a CRC check so that the bootloader accepts the firmware image above (located in the same folder as
the firmware image)

L]
L]
L]
L]

The appropriate files are generally listed in theversion control .xml file (http://adafru.it/fPr) in the firmware repository.

If you are trying to flash the sniffer firmware (at your own risk!), you only need to flash a single .hex file, which you can find
here (http:/adafru.it/fYV). The sniffer doesn't require a SoftDevice image, and doesn't use the fail-safe bootloader -- which is why changing is a one
way and risky operation if you don't have a supported SWD debugger.

Adafruit_nF51822_Flasher

We also have an internal python tool available that sits one level higher than AdaLink (referenced above), and makes it easier to flash specific
versions of the official firmware to a Bluefruit LE module. For details, see the Adafruit nRF51822_Flasher (http://adafru.it/fVL) repo.

Can | access BETA firmware releases?

The latest versions of the Bluefruit LE Connect applications for iOS and Android allow you to optionally update your Bluefruit LE modules with pre-
release or BETA firmware.

This functionality is primarilly provided as a debug and testing mechanism for support issues in the forum, and should only be used when trying to
identify and resolve specific issues with your modules!

Enabling BETA Releases on iOS

e Make sure you have at leastversion 1.7.1 of Bluefruit LE Connect
e Go to the Settings page

e Scroll to the bottom of the Settings page until you findBluefruit LE

e Click on the Bluefruit LE icon and enable the Show beta releases switch

e You should be able to see any BETA releases available in the firmware repo now when you use Bluefruit LE Connect

Enabling BETA Releases on Android

Make sure you have the latest version of Bluefruit LE Connect

Open the Bluefruit LE Connect application

Click the "..." icon in the top-right corner of the app's home screen

Select Settings

Scroll down to the Software Updates section and enable Show beta releases

You should be able to see any BETA releases available in the firmware repo now when you use Bluefruit LE Connect

e o o o o o

Why can't | see my Bluefruit LE device after upgrading to Android 6.0?

In Android 6.0 there weresome important security changes (http://adafru.it/jcU) that affect Bluetooth Low Energy devices. If location services are
unavailable (meaning the GPS is turned off) you won't be able to see Bluetooth Low Energy devices advertising either. See this
issue (http://adafru.it/jcV) for details.

Be sure to enable location services on your Android 6.0 device when using Bluefruit LE Connect or other Bluetooth Low Energy applications with
your Bluefruit LE modules.

What is the theoretical speed limit for BLE?
This depends on a variety of factors, and is determined by the capabilities of the central device (the mobile phone, etc.) as much as the peripheral.

Taking the HW limits on the nR51822 into account (max 6 packets per connection interval, and a minimum connection interval of 7.5ms) you end
up with the following theoretical limits on various mobile operating systems:

o iPhone 5/6 + 10S 8.0/8.1

6 packets * 20 bytes * 1/0.030 s = 4 kB/s = 32 kbps
o iPhone 5/6 + 10S 8.2/8.3

3 packets * 20 bytes * 1/0.030 s = 2 kB/s = 16 kbps
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https://github.com/adafruit/Adafruit_Adalink
https://www.adafruit.com/products/2548
https://github.com/adafruit/Adafruit_BluefruitLE_Firmware
https://github.com/adafruit/Adafruit_BluefruitLE_Firmware/blob/master/releases.xml
https://github.com/adafruit/Adafruit_BluefruitLE_Firmware/tree/master/sniffer/1.0.1
https://github.com/adafruit/Adafruit_nRF51822_Flasher
http://developer.android.com/about/versions/marshmallow/android-6.0-changes.html#behavior-hardware-id
https://code.google.com/p/android/issues/detail?id=190372&q=GPS&colspec=ID Type Status Owner Summary Stars

o iPhone 5/6 + 10S 8.x with nRF8001
1 packet * 20 bytes * 1/0.030 s = 0.67 kB/s = 5.3 kbps

e Nexus 4
4 packets * 20 bytes * 1/0.0075 s = 10.6 kB/s = 84 kbps

o Nordic Master Emulator Firmware (MEFW) with nRF51822 0.9.0
1 packet * 20 bytes * 1/0.0075 = 2.67 kB/s = 21.33 kbps

o Nordic Master Emulator Firmware (MEFW) with nRF51822 0.11.0
6 packets * 20 bytes * 1/0.0075 = 16 kB/s = 128 kbps

There are also some limits imposed by the Bluefruit LE firmware, but we are actively working to significantly improve the throughput in the
upcoming 0.7.0 release, which will be available Q2 2016. The above figures are useful as a theoretical maximum to decide if BLE is appropriate
for you project or not.

Can my Bluefruit board detect other Bluefruit boards or Central devices?

No. All of our Bluefruit LE modules currently operate in peripheral mode, which means they can only advertise their own existence via the
advertising payload. The central device (usually your phone or laptop) is responsible for listening for these advertising packets, starting the
connection process, and inititating any transactions between the devices. There is no way for a Bluefruit module to detect other Bluefruit modules
or central devices in range, they can only send their own advertising data out and wait for a connection request to come in.

How can | determine the distance between my Bluefruit module and my phone in m/ft?
The short answer is: you can't.

RF devices normally measure signal strength using RSSI, which stands for Received Signal Strength Indicator, which is measured in dBm. The
closer the devices are the strong the RSSI value generally is (-90dBm is much weaker than -60dBm, for example), but there is no reliable
relationship between RSSI values in dBm and distance in the real world. If there is a wall between devices, RSSI will fall. If there is a lot of
interference on the same 2.4GHz band, RSSI will fall. Depending on the device, if you simply change the antenna orientation, RSSI will fall. You
can read the RSSI value between two connected devices with the AT+BLEGETRSSI command, but there are no meaningful and repeatable
conclusions that can be drawn from this value about distance other than perhaps 'farther' or 'closer' in a very loose sense of the terms.

How far away from my phone can | have my Bluefruit LE module?

This depends on a number of factors beyond the module itself such as antenna orientation, the antenna design on the phone, transmit power on
the sending node, competing traffic in the same 2.4GHz bandwidth, obstacles between end points, etc.

It could be as low as a couple meters up to about 10 meters line of sight, but generally Bluetooth Low Energy is designed for very short range and
will work best in the 5-6 meter or less range for reliable communication, assuming normal Bluefruit firmware settings.

How many GATT services and characteristics can | create?
For firmware 0.7.0 and higher, the following limitations are present:

Maximum number of services: 10

Maximum number of characteristics: 30

Maximum buffer size for each characteristic: 32 bytes
Maximum number of CCCDs: 16

L]
L]
L]
L]

Is it possible to modify or disable the built in GATT services and characteristics (DIS, DFU, etc.)?

No, unfortunately you can't. We rely on the Device Information Service (http://adafru.it/q9E) (DIS) contents to know which firmware and bootloader
version you are running, and wouldn't be able to provide firmware updates without being able to trust this information, which i why it's both
mandatory and read only.

Similarly, the DFU service is mandatory to maintain over the air updates and disabling it would create more problems that it's presence would
cause.

https://learn.adafruit.com/bluefruit-le-micro-atmega32u4-

© Adafruit Industries . .
microcontroller-usb-bluetooth-le-in-one

Page 111 of 113


https://www.bluetooth.com/specifications/gatt/viewer?attributeXmlFile=org.bluetooth.service.device_information.xml

DFU Bluefruit Updates

For videos on the latest update procedure using Bluefruit LE Connect see:

e iOS: https: //Iearn adafruit. com/mtroducmg adafrwt ble bluetooth-low- energy-frlend/dfu on-ios (http: //adafru it/iCx)

(http://adafru.it/oSD)

The video below is out of date and applies to early versions of the board before the Bluefruit LE Connect apps were available for iOS, Android and
OS X in the respective app stores. To keep your device up to date, simply install and open the Bluefruit LE Connect app and connect to your
Bluefruit device. If a firmware update is available, it will be automatically proposed, and the entire update process will be handled transparently for
you.

You can reprogram the Bluefruit LE module itself over-the-air using an Android or iOS phone/tablet. This doesn't reprogram the ATmega32u4 in
the Bluefruit Micro, only the BLE module itself. Since its not a common thing to do, its a little challenging to do.

You will need to disconnect/unpower the Bluefruit Micro, connect a wire temporarily between theDFU pin and GND and then power up the board
via USB or battery.

The red LED will blink continuously, letting you know it's in DFU mode.Then follow our guide for field updating the firmware (http://adafru.it/iCQ)
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Downloads

Datasheets

ATmega32u4 microcontroller chip datasheet (http://adafru.it/fLz)
MDBT Datasheet (http://adafru.it/oYE)

EagleCAD PCB files on GitHub (http://adafru.it/rzE)

Fritzing object in the Adafruit Fritzing Library (http://adafru.it/aP3)

e o o o

Drivers

o Bluefruit Micro Driver for Windows (http://adafru.it/fLA), drivers not necessary for Mac or Linux

Schematic

For the Bluefruit LE Micro, click to enlarge
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https://github.com/adafruit/Adafruit-Bluefruit-LE-Micro-PCB
https://github.com/adafruit/Fritzing-Library
http://www.adafruit.com/datasheets/PJRC CDC serial_install.zip
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